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This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code
is provided under the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of
or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of con-
ditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list of
conditions in documentation and/or other materials provided with the distribution.

3. Altered versions— including, but not limited to, ports to new operating systems, existing ports with new graph-
ical interfaces, and dynamic, shared, or static library versions—must be plainly marked as such and must not
be misrepresented as being the original source. Such altered versions also must not be misrepresented as
being Info-ZIP releases— including, but not limited to, labeling of the altered versions with the names "Info-ZIP"
(or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or
"MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited frommis-
representative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

____________________________________________________________________________

Copyright © 2021-2022. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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CORPORATE PROFILE
Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size, intrusion porosimetry, powder rheology, and activity testing
of catalysts. The company has R&D and manufacturing sites in the USA, UK, and Spain, and
direct sales and service operations throughout the Americas, Europe, and Asia. Micromeritics
systems are the instruments-of-choice in more than 10,000 laboratories of the world’s most
innovative companies and prestigious government and academic institutions. Our world-class
scientists and responsive support teams enable customer success by applying Micromeritics
technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International: Contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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About this Manual

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.Micromeritics.com).

n Error Messages document (PDF)
n Parts and Accessories

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage
the analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.
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GENERAL SAFETY

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

Any piece of laboratory equipment can become dangerous to personnel when improperly
operated or poorly maintained. All employees operating and maintaining Micromeritics
instruments should be familiar with its operation and should be thoroughly trained and instructed
on safety.

n Read the operator manual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Wear the appropriate personal protective equipment when operating this
instrument — such as eye protection, lab coat, protective gloves, etc.

n When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The 5125 SediGraph II Plus weighs approximately 43 kg
(95 lb). The MasterTech weighs approximately 18 kg (40 lb).

n Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not become worn or damaged.

n Proper maintenance is critical to personnel safety and smooth instrument
operation and performance. Instruments require regular maintenance to help
promote safety, provide an optimum end test result, and to prevent costly down
time. Failure to practice proper maintenance procedures can lead to unsafe
conditions and shorten the life of the instrument.

n Improper handling, disposing of, or transporting potentially hazardous materials
can cause serious bodily harm or damage to the instrument. Always refer to the
MSDS when handling hazardous materials. Safe operation and handling of the
instrument, supplies, and accessories is the responsibility of the operator.

General Safety
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General Safety

INTENDED USE
The SediGraph III Plus determines particle size by using the highly accurate and reproducible
sedimentation technique which measures the gravity-induced settling rates of different size
particles in a liquid with known properties. This is a simple yet extremely effective technique for
providing particle size information for a wide variety of materials.

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer and as well as
relevant hazards involved and prevention methods. Other than what is described in
this manual, all use is seen as unintended use and can cause a safety hazard.

The instrument is intended to be used as per applicable local and national regulations.

TRAINING
It is the customer's responsibility to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.
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ENVIRONMENTALLY FRIENDLY USE PERIOD

Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Cover o o o o o o

Power
Supplies o o o o o o

Printed
Circuit
Boards

x o o o o o

Ultrasonic
Driver
and Probe

x o o o o o

Cables &
Connectors x o o o o o

Part Name

Hazardous Substances
Lead
(Pb)

Mer-
cury
(Hg)

Cad-
mium
(Cd)

Hexa-
valent

Chromium
(Cr (VI))

Poly-
brominated
biphenyls
(PBB)

Poly-
brominated
diphenyl eth-
ers (PBDE)

Cover x o o o o o
Power
Supplies x o o o o o

Printed
Circuit
Boards

x o o o o o

Cables,
Connectors
& Trans-
ducers

x o o o o o

SediGraph III Hazardous Substances Table

MasterTech Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

General Safety
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General Safety

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product
manual.
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SYMBOLS THAT MAY APPEAR ON YOUR INSTRUMENT

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear on your instrument:

Use extreme caution when working on the instrument where one of these symbols
may be displayed. These symbols indicate the part may be hot and cause serious
burns.

Use the cotton gloves provided in the accessory when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

When working on the instrument where this symbol is displayed, refer to your Micro-
meritics' instruction manual for additional information.

When this symbol is displayed, toxic or flammable gases require proper venting of
exhaust.

This symbol can also indicate the instrument uses mercury which is an extremely
toxic substance. Read the Material Safety Data Sheet (MSDS) and be aware of the
hazards of mercury and know what to do in the event of a spill or an exposure
incident

General Safety
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1 ANALYZER COMPONENTS FOR SEDIGRAPH III PLUS
Parts and accessories are located on the Micromeritics web page.

The SediGraph was surveyed for radiation leakage prior to shipping. The radiation
detected was well below the government limits. See SediGraph Safety on page 1 -
4.

FRONT COMPONENTS

A. Mixing chamber
B. X-ray standby

indicator
C. X-ray ON indicator
D. X-ray keyswitch
E. Pump control switch

Component Description
Mixing chamber Contains the sample during an analysis and maintains sample dis-

persion throughout the analysis with a built-in stirrer.
Pump control
Off/Auto switch

Selects the operational mode of the mixing and cell pumps. The OFF
position turns off power to the pumps. The Auto position places the
pumps in automatic mode.

Front Components

1 Analyzer Components for SediGraph III Plus
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1 Analyzer Components for SediGraph III Plus

Component Description
X-ray keyswitch Sets the X-ray to either the ON or STANDBY position.

X-ray ON indicator Illuminates when X-rays are being generated. The X-ray keyswitch must
be turned to the X-RAY ON position.

X-ray standby
indicator

Illuminates when the analyzer is ON and the X-ray keyswitch is turned to
the standby position, when the door to the analysis compartment is
open, or any interlock is disengaged.

Front Components (continued)

SIDE PANEL COMPONENTS

A. Ethernet
port

B. Aux RS-232
C. MasterTech

RS-232

Power switch and electrical inlet

Component Description
Aux RS-232 port For Micromeritics use only.

Ethernet Port Port for a shielded Ethernet cable allowing communication between
the analyzer and the computer.

MasterTech RS-232
port

For connecting the MasterTech to the analyzer.

Side Panel Components
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EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories are located on the Micromeritics web page.

Option Description
MasterTech An automatic sampling device that operates in conjunction with the

SediGraph.

The MasterTech allows up to 18 predispersed samples to be "queued up" and run consecutively
and unattended. It allows samples to be redispersed either by stirring only or by stirring and
disruption with an ultrasonic probe. The MasterTech transfers each sample to the SediGraph,
then after analysis is complete, rinses the mixing chamber, the connecting tubing, and the stirrer.

The MasterTech 052 consists of three main components: the arm assembly, the body, and the
beaker tray. The arm assembly controls the movement of the stirring rotor, the ultrasonic probe,
and the transfer tube. The body houses the electronics, the transfer pump, the front panel
controls, and supports the beaker tray, which holds up to 18 sample beakers.

During operation, the beaker tray is loaded with beakers containing 60 to 80 mL of predispersed
sample.

When the SediGraph is ready for a sample, the tray rotates until the correct sample is underneath
the head of the arm assembly. The head then lowers until it rests on top of the beaker. Stirring
action begins and continues for a user-specified length of time. The ultrasonic probe can be
activated to aid in redispersion.

When redispersion is complete, the pump transfers most of the sample to the SediGraph, where it
is loaded into the mixing chamber. Analysis now proceeds as if the mixing chamber was filled
manually with predispersed sample. When analysis is complete, the contents of the mixing
chamber are disposed to the waste container, and a small amount of rinsing fluid is back-flushed
to the MasterTech to rinse the tubing. The arm rises so that the rinse liquid removes the sample
residue from the stirrer blades and transfer tube. Once rinsing is complete, the arm rises to the Up
position. The MasterTech is now ready to proceed to the next sample.

Equipment Options and Upgrades
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1 Analyzer Components for SediGraph III Plus

SEDIGRAPH SAFETY
In a continuing effort to provide maximum safety to operators of Micromeritics equipment, and to
ensure full compliance with all known government safety regulations regarding X-rays,
Micromeritics provides a high level of X-ray safety on its SediGraph line.

GENERAL

The SediGraph Particle Size Analysis System employs soft X-rays to detect relative particle
concentration because X-ray absorption is directly proportional to particle mass. This X-ray beam
is inaccessible to the operator at all times due to cabinet construction, a door enclosing the cell
compartment, a mechanical shutter that blocks the beam’s entry into the cell compartment when
that door is opened more than 12 mm (0.5 in.), and electrical interlocks that interrupt power to the
X-ray tube when the cell compartment door or top panel is opened.

X-RAY SOURCE
X-rays are generated by a small, air-cooled tube having a tungsten target inclined at 55° to a thin
beryllium window. It is operated at a potential of 13,600 VDC with a power input of less than 41
watts. The greatest value the anode voltage can attain in a malfunction is 15,000 VDC. Only the
tungsten L-lines are excited, of which the L is primary. This primary radiation has an energy of
approximately 10,000 eV and a corresponding wavelength of 0.125 nm (1.25 angstroms). The
integrated radiation density of the direct, unattentuated beam over a 25 mm circular aperture is
between 300 and 400 milliroentgens per hour. The X-ray beam is, for example, 60% blocked by a
51 µm (0.002 in.) thick film of the plastic polyvinyl chloride and essentially completely blocked by
130 µm (0.005 in.) thick steel. Nevertheless, the shutter mechanism should never be defeated.

Radiation levels outside the instrument or in the cell compartment when the compartment door is
open are well below 0.5 milliroentgen per hour. Most jurisdictions require the registration of
radiation producing devices regardless of kind or intensity level. Check with the appropriate
authority in your area1 ) .

Since a potential of 13,600 VDC and a current of up to 3 mA generate the X-rays, the instrument
should be unplugged from the power source before any panel is removed for any purpose. This
ensures that X-ray generation ceases and high voltages are eliminated.

1 ) Based on the above information, SediGraph users in the State of Georgia have regularly been
granted waivers to the State of Georgia “Rules and Regulations for X-ray” by the Radiological
Health Section of the Georgia Department of Human Resources.
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WARNING AND INDICATOR LIGHTS
The SediGraph control switches and indicators are located on the front panel of the analytical unit
and include a keyswitch to turn the X-ray tube on. The key is held captive when the keyswitch is
on. There are two warning lights: An amber X-RAY STANDBY light and a red X-RAY ON light.
With the analytical unit connected to the electric mains and the power switch on, the amber X-RAY
STANDBY light is lit. Turning the keyswitch to the ON position causes the red X-RAY ON light to
illuminate signaling that power is applied to the X-ray tube. When the X-RAY ON light is
illuminated, power is applied to both the filament and anode of the X-ray tube. If the X-RAY ON
lamp filament burns out, then power is interrupted to both the filament and anode of the X-ray
tube. In order for power to be supplied to the X-ray tube filament and anode when a failure (open
circuit) occurs in the X-RAY ON light, concurrent failures must occur in two independent circuits
such that these circuits continue to supply power to the X-ray tube.

The SediGraph has magnetically actuated reed switches. These switches are in series with the X-
RAY ON lamp filament. Whenever the top or rear panel of the SediGraph is removed, the cell-
compartment door is opened, the fluid module is removed, or the X-RAY ON lamp filament burns
out (opens), both filament and anode power to the X-ray tube are interrupted.

These switches are in addition to the mechanical shutter which operates when the cell
compartment door is opened, blocking X-rays and removes filament power when the top cover is
removed. During the last 12 mm (0.5 in.) of travel of the cell compartment door to the fully closed
position, the sliding pin actuates the gravity-operated, spring-assisted shutter so that the shutter is
opened to allow X-rays to enter the cell compartment. When the cell compartment door is opened
from the fully closed position, the shutter is actuated during the first 12 mm (0.5 in.) of travel to
close and block x-rays from entering the cell compartment. As long as the cell compartment door
remains open, the shutter blocks X-rays from entering the cell compartment and the X-ray
Detection Indicator remains off.

Now, when the cell compartment door is opened, not only does the shutter block the X-ray beam
but the power to the X-ray tube also is interrupted.

SediGraph Safety
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1 Analyzer Components for SediGraph III Plus

SEDIGRAPH X-RAY CERTIFICATION
X-radiation in the Micromeritics SediGraph III Plus is electronically generated by a tungsten target
x-ray tube operated at 13,600 volts of regulated DC. X-ray tube current is nominally 1.0 mA and
cannot exceed 3.5 mA in the event of any failure of circuit components . The x-rays are derived
from excitation of the L electron shell (primarily La). The operating wavelength corresponds to
approximately 8.3KeV of photon energy. The integrated radiation density of the direct,
unattenuated beam over a 25 mm circular aperture is between 300 and 400 milliroentege ns per
hour. By definition, all x-rays consist of ionizing radiation. There is no emission of x-radiation
unless the x-ray tube is supplied with electrical power. When power is removed from the
x-ray tube, there is no generation of x-rays and there is no residual x-ray radiation nor
any other type of radiation.

The SediGraph III Plus is designed to prevent x-radiation exposure of personnel through the use
of interlocks and shielding. All SediGraph Ill Pius instruments are tested for x-radiation leakage.
Maximum allowable external levels are 0.02 mrem/hr (200 nSv/hr) at 0.05 m (5 cm). Typical value
is 0.002 mrem/hr (20 nSv/hr).

Primary electrical power to the x-ray tube is controlled by a master key switch. The key is
removable to prevent unauthorized personnel from operating the instrument.

The SediGraph III Plus has three types of safety interlocks used to prevent x-radiation exposure.
Three interlock switches are located under the top panel of the SediGraph lII Plus and a magnetic
switch is mounted on the sample compartment door. When any of the switches are actuated,
electrical power to the x-ray tube is removed and the emission of x-radiation ceases. Top panel
removal and replacement subsequently requires that the key switch be cycled to restore x-ray
generation.

Redundancy is built into the sample compartment door interlocks. In addition to the electrical door
interlock, the SediGraph III Plus also has a gravity-operated mechanical shutter which blocks the
x-ray beam from entering the sample compartment when the sample compartment door begins to
open. Both of these door interlocks function before the door moves out of the frame grooves.

Two warning lights on the front of the SediGraph III Plus indicate the status of the x-ray tube. The
X-RAY STANDBY light indicates that the potential of emitting x-rays exists but that x-rays are not
now present. X-ray emission from standby status could require only a single switch operation. The
X-RAY ON light indicates that x-rays are being produced. If the X- RAY ON light bums out, this is
detected by the electronics, which will not allow x-rays to be produced until filament continuity is
re-established.

The SediGraph III Plus cabinet, analysis compartment , x-ray compartment cover, and base plate
are designed as x-ray shields . In additional , extra shield panels are mounted inside the
SediGraph lII Plus to further minimize the likelihood of any x-ray exposure if other shields are
removed (e.g., in servicing).
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SPECIFICATIONS FOR THE SEDIGRAPH III PLUS

Particle Diameter Range 300 to 0.1 micrometers Equivalent Spherical Diameter

Wetted Materials

Stainless steel, Teflon impregnated anodized aluminum, nickel
plated aluminum, nylon, polypropylene, polystyrene, Tygon and
Pharmed tubing, tungsten carbide, Ertalyte, Viton, Buna-N, and
epoxy.

Sample Size 50 mL of dispersed sample. Precise concentration is not required.

Suspending Liquids
Any liquid compatible with sample cell materials and not highly
absorptive of X-rays. Typical liquids are water, glycols, mineral oils,
SediSperse, and alcohols.

Voltage 100-240 VAC

Power 450VA, maximum

Frequency 50/60Hz

Overvoltage category II

Electrical

Height 52 cm (21 in.)

Width 51 cm (20 in.)

Depth 58 cm (23 in.)

Weight 43 kg (95 lbs)

Physical

Specifications for the SediGraph III Plus
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1 Analyzer Components for SediGraph III Plus

Temperature 10 to 40 °C (50 to 104 °F), operating
-10 to 55 °C (14 to 131 °F), non-operating

Humidity 20 to 80% relative, non-condensing

Indoor or outdoor use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax (6500 ft)
Pollution degree of the intended environment: 2

Degree of Ingress
Protection IPX0

Environment

Operating System Windows 10 or higher operating system is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Ensure the "Sleep" setting on the desktop is set to
"Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection
is not successful.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required.

Read/Write Permissions All application users will need Read/Write permission to all
directories and subdirectories where the application is installed.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.
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MASTERTECH COMPONENTS (OPTIONAL ACCESSORY)
Parts and accessories are located on the Micromeritics web page.

A. Probe cable
B. Arm assembly
C. Ultrasonic probe
D. Arm
E. Cylinder Slots (one on each side)
F. Ultrasonic power display
G. Tray

The MasterTech is an optional accessory that features an ultrasonic probe with a 1/4 in. probe tip
to supply more dispersion power to the sample. Power to the probe tip is adjustable and the
driving circuit is self-tuning for maintaining efficient and consistent sonic energy from the input
power. A digital readout on the front panel assures that the desired power is reached for
dispersing each sample and that the same power is applied each time the method is repeated.

When the instrument is ready to analyze a sample, the tray rotates until the selected sample is
underneath the arm assembly. The arm assembly lowers and stirring begins. Stirring continues
until the sample is thoroughly resuspended. At a predetermined time (specified through the
software), the ultrasonic probe can be activated to aid in dispersion. After redispersion is
complete, the MasterTech transfers the sample to the mixing chamber of the SediGraph for
analysis.

MasterTech Components (Optional Accessory)

SediGraph III Plus Operator Manual
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1 Analyzer Components for SediGraph III Plus

FRONT COMPONENTS

A. Intensity display
B. Ultrasonic probe AUTO/ON switch
C. Intensity control
D. Arm AUTO/LOAD switch
E. Pump AUTO/OFF switch
F. Transfer tube connector

Component Description
Arm AUTO/LOAD
switch

The LEDs on the switch indicate the mode of operation.

Do not press the ARM AUTO/LOAD switch while an auto-
matic operation is in progress.

n AUTO. Places the arm under automatic control.
n LOAD. Raises the arm to remove or load the tray.

This switch will not work unless the computer is installed and the
analyzer software is operating.

Ensure the LOAD switch has been released when finished removing or
loading the beaker tray. The MasterTech will not operate if the arm is in
the Load position.

Intensity control n Turn clockwise to increase the intensity of the probe.
n Turn counterclockwise to decrease the intensity.

Power Display Displays the power being generated by the ultrasonic probe.

Pump
AUTO/OFF switch

The LEDs on the switch indicate the mode of operation.

n AUTO. Places the pump under automatic control.
n OFF. Powers off the pump.

Transfer tubing
connectors

Attach the tubing to the side that coordinates with the one used on the
MasterTech pump during installation of the MasterTech.

Front Components
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Component Description
Ultrasonic probe
AUTO/ON switch

LEDs on the switch indicate the mode of operation.

n AUTO position. Places the probe under automatic control.
n ON position. Turns on the probe. Remove the probe from its holder

and place it in the liquid before turning on the probe.

Never turn the probe on unless the tip is submerged in
liquid.

After using the probe, press the switch again to place the probe in
automatic mode. Then replace it in its holder.

Front Components (continued)

REAR COMPONENTS

A. Power switch, power connector, and
voltage selector card

B. +5 and +24 VDC indicators
C. RS-232 connector

Component Description
+5 and +24
VDC Indicators

Illuminates when appropriate power is present in the MasterTech.

Power switch, power
connector, voltage
selector card

Powers the MasterTech on and off.

RS-232 Connector Connects the MasterTech to the analyzer.

Rear Panel Components

MasterTech Components (Optional Accessory)
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1 Analyzer Components for SediGraph III Plus

SPECIFICATIONS FOR THE MASTERTECH

Sample Capacity 18 per tray; continues indefinitely if tray is replenished

Sample Size 0.5 to 4 g of powder in 60 to 80 mL of liquid

Sample Type Any suitable for SediGraph 5100 analysis

Suspending liquids
Any liquid compatible with sample cell materials and not highly
absorptive of X-rays. Typical liquids are water, glycols, kerosene,
mineral oils, alcohols, Sedisperse, and mineral spirits.

Wetted Materials Glass, stainless steel, Viton, Tygon, Silicone rubber, Polypro-
pylene

Voltage 100/120/220/240VAC ± 10%

Frequency 50/60 Hz

Power 180 VA maximum

Current 1.25 A (100/120VAC)
0.75 A (220/240VAC)

Electrical
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Temperature 10 to 40 °C (50 to 104 °F), operating
-10 to 55 °C (14 to 131 °F), non-operating

Humidity 20 to 80% relative, non-condensing

Indoor or outdoor use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax (6500 ft)
Pollution degree of the intended environment: 2

Degree of Ingress
Protection IPX0

Environment

Height 69 cm (27.25 in.) maximum at load position

Width 46 cm (18.25 in.)

Depth 54 cm (21.25 in.)

Weight 18 kg (40 lbs)

Physical

Due to continuous improvements, specifications are subject to change without notice.

Specifications for the MasterTech
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2 ABOUT THE SOFTWARE

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Helpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

MENU STRUCTURE
All program functions use standard Windows menu functionality.

Selections Description
File Use to manage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Up

to two analyzers can be installed on the same computer.
Reports Use to start or initiate reports and view the results.

Options Use to change presentation options, set the method and active metals
defaults, configure signal calibration, manage libraries, select units, and
create report styles.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Use to access the embedded operator manual, Micromeritics web page,
and information about the application.

Main Menu Bar Options

2 About the Software
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2 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Selections Description
Add Adds an item to the list.

Add Log Entry Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscalemeans that the x- and y- ranges
will be set to show all the data. If Autoscale is not selected, the entered
range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Use to enter additional information about the sample, such as a sample
lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window and displays a prompt to either accept or
reject changes.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments to display in the report header about the sample or
analysis.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables, deletes the selected information.

Destination Selects the report destination.

Common Fields and Buttons
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Selections Description
Edit When working with report parameters, highlight the item in the Selected

Reports list box and click Edit to modify the report details.
Exit Exits the application. If a file is open with unsaved changes, a prompt

displays the option to save the changes and exit or exit the application
without saving the changes. If an analyzer is currently operating, an
additional prompt displays to confirm exiting from the software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field or accept the default. Select to save the file as a spread-
sheet (.XLS), a portable document format (.PDF), or an ASCII text
(.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Indicates the From and To range for x- and/or y-axes when working
with report parameters windows.

Insert Inserts one row above the selected row in the table.

List Creates a list of samples or other types of files. The list will contain the
file name, date/time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

Selections Description
Replace All Selects another .SMP file where the values will replace all values for

the active sample file. The original file will remain unchanged. No
analysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis, and
reporting parameters.

Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. A portion
can be saved as a separate, stand-alone file, such as Analysis Condi-
tions or Report Options, when saving sample information.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages. Enabled only in Service Test Mode.

Instrument Schematic. Displays a schematic of the analyzer system.

Common Fields and Buttons (continued)
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FILE STATUS
In the File Selector window, theMic Description column and theMic Status column display the file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status Description
Analyzing Sample files that are currently used for analysis.

Complete Sample files used in an analysis that is completed.

Entered Sample files containing manually entered data.

No Analysis Sample files that have not been used to perform an analysis.

File Status

File Type File Name
Extension

Analysis Conditions .ANC

Export to Disk (Text) .TXT

Liquid Properties .LIQ

Report Options .RPO

Report to Disk .RPT

Sample Information .SMP

File Type and File Name Extension

File Status
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressingO to open the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Selections Description
Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to

save changes displays.
F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

Keyboard Shortcuts
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OPTION PRESENTATION
Options > Option Presentation
Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window like the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered
to change to the Basic or Advanced display option. This display type
is typically used in laboratories — such as the pharmaceutical
industry — where analysis conditions must remain constant. The
Advanced option is not available in the view selector at the bottom of
the window when using the Restricted display option.

Always Open Edit View Opens files with a Complete status in the tabbed file editor rather
than in the Peak Editor view.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation
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2 About the Software

Advanced view Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.

2 - 8 SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022



LIBRARIES
Options > Manage Libraries

This feature is not available when using Restricted option presentation.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files stored in multiple locations, such as folders on a C:
drive, a network location, a connected external hard drive, or a connected USB flash drive, and
provides access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items, such as saved searches and search
connectors, cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.

Libraries

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 2 - 9



2 About the Software

METHODS

Options > Default Method
File > Open > [.MTH File]
AMethod determines the default sample identification format and sequence number. AMethod is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed. Only a single selection
is required for each new sample file created.

TheMethod drop-down list displays only those methods applicable to the open sample file type.

Default Method Example Sample Information File Example

Selections Description
Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labels may be renamed, and the new label becomes a
part of all new sample files.

Sequence Number
[text box]

Specify a default numeric string to use as a prefix in the Sample field
when a new sample file is created. This number increments with
each sample file created.

Default Methods
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CONFIGURE THE ANALYZER

UNIT CONFIGURATION

Unit [n] > Unit Configuration

Use to display and confirm hardware and software configurations and calibrations of the analyzer.

Selections Description
Analyses per tubing set
[group box]

Enable analysis counter. Enables or disables the analyses
counter. The analysis program keeps a counter of the number of
analyses remaining before the next recommended tubing change.
For every sample information file for which an analysis is started
(excluding service tests or baseline measurements) this counter is
decremented.

Max recommended analyses per tubing set. Maximum number of
analyses to be performed before the application displays this
message:

The maximum number of analyses for this tubing has been
reached. It is time to change the tubing. When the tubing has
been replaced, reset the counter in the unit configuration
dialog.

Analyses remaining on current tubing. Number of analyses
remaining before the maximum recommended number is reached.

Reset button. Resets the counter to the recommended maximum
number.

Unit Configuration

Configure the Analyzer
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2 About the Software

Selections Description
Baseline [group box] Displays the Date and the Average Intensity of the last baseline per-

formed.
Board ID [button] Displays the IP address used by the analysis program, serial

number, and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP. Displays the Board ID dialog, which describes the circuit
boards in the analyzer. Use the Board drop-down list to select a
board to view.

Board ID. Click to display information from the circuit boards in the
analyzer. Use the drop-down list to select a board to view. The
parameters shown cannot be edited.

Calibration [group box] Displays calibration information for analyzer components.

Configuration
[group box]

Displays the IP address used by the analysis program, serial
number, and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP. Displays the Board ID dialog, which describes the circuit
boards in the analyzer. Use the Board drop-down list to select a
board to view.

Board ID. Click to display information from the circuit boards in the
analyzer. Use the drop-down list to select a board to view. The
parameters shown cannot be edited.

Reset [button] Resets the analysis counter to the recommended maximum number.

Unit Configuration (continued)
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Selections Description
Set Temperature
[button]

Enter the target temperature in the Set Point field.

Software Versions
[group box]

Version of the installed software application.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Unit Configuration (continued)

Unit Configuration
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2 About the Software

SIEVE TABLE

Options > Sieves
Sieves specifies the default sieve sizes to use when sieve data are presented. The sieve sizes
follow the technical specifications per ASTM Specification E-11.

REYNOLDS NUMBER

Options > Reynolds Number
Specifies the Reynolds number to be used in estimating the maximummeasurable diameter
displayed on theMaterial Properties window.
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AUTORINSE

Options > Autorinse
Use to specify autorinse options. The system default for Autorinse is 3 cycles of 3 rinses per cycle.
The analyzer will rinse a maximum of 9 times in an attempt to reestablish baseline conditions
before displaying an error message.

Selections Description
Number of rinses
before check [text box]

Number of rinses per cycle to be performed after each analysis
before baseline conditions are checked.

Maximum number of
checks [text box]

Maximum number of baseline checks to be performed before noti-
fication that baseline conditions have not been met.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Autorinse

Autorinse
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2 About the Software

INVERT SIZE AXIS

Options > Invert Size Axis

Use to invert the size axis.

UNIT SELECTION

Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.
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REPORT STYLE

Options > Report Style
A report style can also be configured from an analysis with a Completed status.

Selections Description
Curve Thickness
[text box]

Enter a value to indicate the thickness of the curve on reports.

Font Options Click Edit to select font type, font style, and font size.

Histogram fill style
[drop-down box]

Select how histograms are to appear on the report.

Linear Scale
Logarithmic Scale
[check box]

Select major and/or minor lines to display in reports for the log-
arithmic and linear scales. Deselect this option to remove the grid
lines.

Major Gridline
Minor Gridline [button]

Select if the major and/or minor grid lines should appear as solid or
dotted lines.

Plot border line
thickness [text box]

Enter a value to indicate the thickness of the plot borders on reports.

Show bitmap [text box] Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Report Style

Report Style
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2 About the Software

Selections Description
Show report title
[text box]

Select then enter a report title to appear on the report header.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Report Style (continued)
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INSTRUMENT STATUS

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log
Use to display a log of recent analyses, calibrations, errors, or messages. The information is
logged for a 7-day period for analyses and a 30-day period for messages and calibrations.

Selections Description
Add Log Entry [button] Use to enter information to appear in the sample log report that can-

not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

Report [button] Click to select the print destination and the report start date.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Instrument Log

Instrument Status
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2 About the Software

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Select this option to display a schematic of the analyzer and the MasterTech (if one is being used).

To operate the valves from this window, manual control must be enabled (Unit [n] > Enable
Manual Control).

A. MasterTech pump
B. Mixing pump
C. Mixing chamber
D. Cell pump
E. Analysis cell
F. MasterTech arm
G. MasterTech stirrer
H. MasterTech Beaker

Items in the red box show only if
MasterTech is installed

The colors of the valves and pumps indicate their state:

Valves
n White: Closed or Off (when manual control is disabled)
n Yellow: Closed or Off (when manual control is enabled)
n Green: Opened

Pumps

n White: Off (when manual control is disabled)
n Yellow: Off (when manual control is enabled)
n Green: On
n Red: Indicates the pump is disabled.

Right-click a component to display pop-up menus.
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Component Description
Air Valve Sets the position of the air valve.

Cell Controls the movement of the analysis cell. An arrow in the cell
symbol indicates the direction of cell movement.

Move Cell Position. Enter the cell position.

Absolute. Move the cell position to an absolute (relative to the last
beamsplit location) number of steps. For example, an absolute move
of 100 steps moves the cell 100 steps above beamsplit.

Relative. Move the cell position to a relative (relative to current
position) number of steps. For example, a relative move of 100 steps
moves the cell up 100 steps from its current position.

Cell Position.Move the cell to the position entered.

Stop Motion. Stop cell movement.

X-ray intensity Normal / Low. Select the X-ray intensity setting.

Find Beamsplit. Zeros the cell position at the proper beamsplit
location.

Start. Progress messages display.

Done. Close the window.
Cell Pump Turn Off / Turn On. Turns the cell pump off or on.

Flow up / Down in a cell. Changes flow direction. Arrows in the
pump symbol display the current direction.

Increase / Decrease Speed. Changes the cell pump speed. The
speed of the cell pump can be set from 1 to 5, with 1 being the
slowest speed.

MasterTech
(if installed)

Move Arm Up / Down.MasterTech arm movement control.

Ultrasonic On / Off. Turn the ultrasonic probe on or off.

Stirrer On / Off. Turn the stirrer in the beaker on or off.

Stirrer Speed Fast / Slow. Stirrer speed control.

Move to beaker.Move the beaker to the next beaker position.

Schematic

Show Instrument Schematic
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2 About the Software

Component Description
Turn On / Off. Turn the MasterTech pump on and off.

Flow Direction Rinse / Load. Set the flow direction of the
MasterTech pump. An arrow in the pump symbol changes to show
the current flow direction.

Mix Pump Turns the mixing pump on or off.

Mixing Chamber The speed of the mixing chamber magnetic stirrer can be set from 1
to 10, with 1 being the lowest speed.

Set Speed. Controls the stirrer speed by entering a value from 1 to
10.

Speed. Displays the Mixing Chamber Speed window.

Turns the stirrer on or off.
Rinse Valve Set the rinse valve position.

Set Temperature Set Temperature. Use to set the target temperature.

Set Point. Enter a temperature set point. Range 25.0 to 50.0 °C. The
set point must be at least 10 °C above ambient temperature for
accurate control.

Waste Valve Set the waste valve position.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Schematic (continued)
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SHOW STATUS

Unit [n] > Show Status
Use to show the current status for each port.

Use this option if:

n There is an automatic operation in progress and a sample file needs to be edited.
n There are two units attached to the computer. Select Show Status on each unit menu and have

the status for both units displayed simultaneously.

If multiple units are attached to the computer, select Show Status on each Unit [n]menu. The
status for all units displays.

Selections Description
Cell Temp. Temperature of the liquid in the analysis cell.

Diameter Current particle size in the analysis.

Mass Percent Current mass percent in the analysis.

MasterTech MasterTech status (if installed).

Mode Type of operation being performed.

Sample Sample file involved in the operation.

SediGraph Analyzer status— such as Analysis operation in progress, Idle,Wait-
ing for load, etc.

Time Remaining Time remaining on the analysis if an analysis is in progress.

X-ray Counts Intensity of the X-ray in kilocounts/sec.

Show Status
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2 About the Software

EXPORT FILES
File > Export
Exported Data Example on page D - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to a file.

1. Click List and open an .SMP file.
2. Select an experiment and the applicable options.
3. ClickOK.

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.
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Example of
File List

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

The Setup program is located on the installation media and is used to reinstall the software and
make analyzer changes— such as adding, moving, or removing a unit, etc.

If the IP address needs to be changed on the computer connected to the analyzer,
refer to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP address must be 192.168.77.100.

Software Setup
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2 About the Software

SOFTWARE UNINSTALL
The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.

SOFTWARE UPDATES

A User Account Control in the Windows operating systemmust be enabled to ensure
all components of the Micromeritics application are correctly installed. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.Micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.
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3 SAMPLE FILES
Option Presentation on page 2 - 7

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, specifies report options, and may be
displayed in Advanced, Basic, or Restricted presentation display mode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either before or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

3 Sample Files
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3 Sample Files

CREATE SAMPLE FILES
File > New Sample > [.SMP File]

File > Open > [.SMP File]
Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation are selected from parameter files created in
the Advanced option presentation. The values specified in the parameter portions of the default
method are the defaults for new sample files. To navigate from one set of parameters to another,
select the parameter tab across the top of the window.

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Selections Description
Add Log Entry [button] Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] * Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Method [drop-down box] Select a method from the drop-down list.

Operator [text box] * Enter operator identification information.

Sample [text box] * Enter a sample description.

Submitter [text box] * Enter submitter identification information.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Sample Files

* This field label may have been renamed or may not display if modified inOptions > Default
Methods.
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OPEN A SAMPLE FILE
File > Open > [.SMP File]

When working with an existing sample file, consider copying the sample file to
maintain the original configuration options.

File Status Displays
No Analysis Tabbed file editor

Complete
Analyzing
Entered

MicroActive report window

Tabbed file editor in
Advanced view Example of a Report window

To view the tabbed file editor for a sample file with a Complete status, select Advanced from the
view selector drop-down list at the bottom of the window.

Open a Sample File
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3 Sample Files

MANUALLY ENTER DATA
This process allows the manual entry of data from a sample file with a Complete status. There are
two methods for manually entering data into a sample file:

n Copy and paste onto the graph area of the interactive window.
n Import data into the interactive window.

COPY AND PASTE MANUALLY ENTERED DATA

To display the file status in a search window, go to File > Open. Right-click the
column header then clickMore... Scroll to theMIC entries and enableMIC Status.This
is a snippet

1. Open a sample file with a Complete status. The file will open in the interactive reports win-
dow.

2. Right-click in the graph area of the interactive reports window, then select Copy data.

3. Open another sample file using the Advanced option presentation.
4. On the Sample Description tab, selectManually entered in the Type of Data group box.
5. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Particle Size.
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6. Ensure that all parameter fields are set appropriately, then click Paste.

Manually Enter Data
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3 Sample Files

IMPORT MANUALLY ENTERED DATA
When importing data from an external ASCII text file using the Import button on the interactive
window, the ASCII text file must use the following ASCII text file format rules:

n Data must be in two columns and separated by a comma or white-space.
n Only cumulative distributions can be imported.
n An acceptable header should be in the format shown below where Diameter or Radius and

Cumulative Coarser or Cumulative Finer can be used.
n Size units of micrometers are required.
n The distribution can beMass, Number, or Area.

Example:

Cumulative Coarser Mass Fraction vs Diameter
Particle (µm) Cumulative Coarser Mass Fraction

To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. On the Sample Description tab, selectManually entered.
3. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Particle Size.
4. Ensure that all parameter fields are set appropriately, then click Import.

5. Open the .TXT file. The data from the original sample file is imported and displayed. If an
error message displays instead, verify that the .TXT file format is correct.
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MERGE DATA
Use to merge data collected from an external source.

PASTE DATA FROM AN EXTERNAL SOURCE

1. Open the sample file with a Complete status.
2. Copy the external source data onto the clipboard.
3. On the Report window, clickMerge Data, then selectMerge with external data, then click

Paste.

IMPORT DATA FROM AN EXTERNAL SOURCE

1. Open the sample file with a Complete status.
2. On the Report window, clickMerge Data, then selectMerge with external data, then click

Import
3. Locate the .TXT file to import, then clickOpen.

Merge Data
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4 PARAMETER FILES
Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed, or new
parameter files created.

The following file types can exist as part of the sample file as well as individual parameter files.

File Type File Name
Extension

Analysis Conditions .ANC

Liquid Properties .LIQ

Report Options .RPO

Sample Information .SMP

Method .MTH

File Type and File Name Extension

4 Parameter Files
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4 Parameter Files

MATERIAL PROPERTIES
File > Open > Analysis Conditions
Or, click theMaterial Properties tab when in Advanced option presentation.

Selections Description
Analysis liquid
[group box]

Displays a list of the Liquid Properties files.

Description. Enter the name of analysis liquids to add to the list.

X-ray Intensity. Displays the X-ray intensity selected for the analysis
liquid. The intensity is selected in Liquid Properties window.

Add. Click to add analysis liquids to the list and change values for an
analysis liquid.

n To add analysis liquids: In the Description field, enter the name of
the liquid, then click Add.

n To change values of an analysis liquid: Highlight the liquid, then
click Properties. Enter the new values, then clickOK. Add changes
to Change; click Change.

Delete. Click to delete the selected liquid from the list.

Properties. Click to edit the properties of the analysis liquid. See Liquid
Properties on page 4 - 10.

Material Properties
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Selections Description
Analysis Type
[group box]

Specifies if the analysis is standard, high speed or high resolution.

n Standard. Provides good resolution and average analysis time.
n High speed. Allows a faster analysis, but a little lower resolution.
n High resolution. Provides high resolution at the smallest diameters,

but takes a longer time.

Starting diameter. Specify the range of sizes to be included in the
analysis. The starting diameter generally should be larger than the
largest particle expected to be in the sample.

Ending diameter. The ending diameter must be less than the smallest
size particle of interest. Each time the values in these fields are
changed, the analysis statistics are updated. A note also is added to the
report header indicating changes have been made since the first
analysis was performed.

Analysis Unit
[group box]

Displays a list of the attached units and their temperatures. The
displayed temperature is used to compute analysis statistics.

n Reynolds number. Calculated for the starting diameter using the
sample’s density and the liquid’s density and viscosity. If this number
is greater than 0.3, large particles falling through the liquid may cre-
ate turbulence, affecting both their velocity and the velocity of neigh-
boring smaller particles. This results in an incorrect particle size
distribution.

n Maximum diameter. Calculated to have a Reynolds number
equivalent to the one entered as a default (from theOptionsmenu). If
the sample has more than a couple percent mass of particles larger
than this diameter, the sample should be analyzed in a liquid with a
higher viscosity.

The Maximum diameter field should be greater than the starting
diameter specified in step 8. The Reynolds number should be less
than 0.3.

n Analysis time. Calculated based on the sample density, liquid dens-
ity and viscosity, and ending diameter. The actual analysis time may
vary slightly if the analysis compartment temperature is different
when the analysis takes place.

The Reynolds number,Maximum diameter, and Analysis time fields

Material Properties (continued)

Material Properties

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 4 - 3



4 Parameter Files

Selections Description

display analysis statistics. These values are updated whenever a
parameter affecting their computation is changed.

If... Then...
the maximum diameter and Reyn-
olds number values are not
attained

a dispersing liquid with a higher
viscosity must be used.

the maximum diameter is much
greater than the starting diameter
and the Reynolds number is
much less than 0.3

a lower viscosity liquid (if avail-
able) may be used.

Description [text box] Description of the Analysis Conditions file.

Sample Material
[group box]

Displays a list of available sample materials. When a sample material is
selected, the description and density display.

Description. Name of sample materials to add to the list.

Density. Density of the sample material selected from the list.

Add. Adds sample materials to the list.

n To add samples materials: In the Description field, enter the name
of the sample material. Click Add.

n To change values of the sample material density: Highlight the
sample material in the list, then enter the density value in the Density
field.

Delete. Deletes sample materials from the list.

Material Properties (continued)
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Selections Description
Update Properties
[button]

Allows the updating of the material properties of a completed analysis.
This allows the collected data to be reprocessed based upon the new
properties.

The material properties for the original analysis remain unchanged. A
note is added to the report header describing the change.

The contents of the Sample Material and Analysis Liquid group boxes
are described elsewhere in this table.

Set Baseline. Applies a baseline different than the one active in the
original analysis. From the drop-down list, select the instrument
containing the baseline to use, then select Use alternate baseline. The
original baseline is preserved.

From the drop-down list, select the instrument containing the baseline to
use, then select Use alternate baseline. The original baseline is
preserved.

Material Properties (continued)

Material Properties
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4 Parameter Files

Selections Description
Apply Changes. Select to apply all changes to the material properties.

Click Yes at the prompt. All test data will be converted to the new data
reduction options. Do you wish to continue? The data are converted and
this prompt displays: Application of new reduction options [file name] is
complete.

ClickOK to close the message box.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Material Properties (continued)
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ANALYSIS OPTIONS

File > Open > Analysis Conditions
Or, click the Analysis Options tab when in Advanced option presentation.

Provides details for setting up the sample analysis conditions file. Analysis options can be edited
as long as the analysis is not in progress and the sample file does not contain manually entered
data. Changes made to analysis parameters are noted in the report header upon completion of
the analysis.

Selections Description
Full scale scan
[group box]

Pump speed. The speed at which the cell pump should operate
during the full-scale scan. Use a pump speed of 2 or 3 if analyzing
fine samples since they pump through the tubing easily. If analyzing
coarse particles, especially if dispersed in higher viscosity liquids, a
higher pump speed of 4 to 5 should be used. If the analyzer has the
smaller 5 mm (3/16 in.) OD tubing, higher speeds may be required
for finer particles.

Bubble detection. Types of bubble detection (Fine,Medium, or
Coarse).

The presence of most bubbles in the cell can be detected during the
full-scale scan that takes place at the start of the analysis. Detecting
bubbles, however, is somewhat sample-dependent. Samples, which
contain very large particles, may appear to have bubbles near the
top of the cell, when actually the sudden change in X-ray intensity is
due to incomplete filling of the topmost portion of the analysis cell.

Analysis Options

Analysis Options
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4 Parameter Files

Selections Description
For samples of this type, select Coarse bubble detection.

If only small particles are present in the sample (less than 1 mm),
select Fine bubble detection.

For samples between these two ranges, selectMedium bubble
detection.

Leave pump on during
analysis [check box]

Coarse materials tend to settle in the tubing during analysis. This
option allows the pump to operate during analysis, enabling easier
rinsing and resuspension of the sample.

MasterTech treatment
[group box]

(Applicable only if using a MasterTech.)

Samples tend to settle in the beakers while waiting for sample
analysis, especially if samples are prepared ahead of time, as in
most cases when using a MasterTech. Program the MasterTech
stirrer and probe to redisperse the sample using options in the group
box.

Stirrer time. The number of seconds to have the stirrer operate
during resuspension.

Stirrer speed. Options include High and Low. Coarse materials and
less-stable dispersions may require more high-speed stirring than
finer materials. Range: 1 to 10, with 1 being the slowest

Probe time. Length of time for the ultrasonic probe to operate during
resuspension. Coarse materials and less-stable dispersions may
require more high-speed stirring than finer materials.

Mixing chamber stirrer
speed [text box]

Adjusts the speed of the magnetic stirring bar which stirs the mixture
in the mixing chamber. Select a number between 1 and 10. 1 rep-
resents the lowest speed and 10 the highest.

Number of tests
[text box]

The number of analyses to be performed.

Analysis Options (continued)
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Selections Description
Rinse [group box] Rinse after analysis. Select if a rinse cycle should be performed

after analysis.

Autorinse. Performs up to 3 cycles of 3 rinses each (a total of 9
rinses) in an attempt to re-establish baseline conditions. If conditions
are not re-established after 9 rinses, an error message is displayed.

Rinses. The number of rinses to be performed.

Pump speed. The speed for the cell pump to operate during rinsing.
The range is 1 to 5, with 1 being the slowest.

Stop at selected mass
percent [check box]

Stops analysis at a specified mass percent finer.

If unsure of the smallest size particle present in the sample, it may be
difficult to determine an ending diameter which will include the
selected data. With this option, choose to end mass percent at 0%,
after having set the ending diameter at a small value of
approximately 0.1 μm. Using this method, wait time is lessened at
the end of the analysis.

Ending percent finer. Enabled only if Stop at selected mass
percent is selected. Enter the point at which the analysis should stop.

Wait for temperature
stabilization [check box]

Select to have the temperature in the analysis compartment and
mixing chamber stabilize to within ± 0.5 °C of the setpoint before the
analysis begins.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Analysis Options (continued)

Analysis Options

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 4 - 9



4 Parameter Files

LIQUID PROPERTIES
File > Open > Liquid Properties
Or, click the Properties button on theMaterials Property tab when in Advanced option
presentation.

Use to edit the properties of an analysis liquid and to specify properties for a new liquid properties
file.

The liquid properties are edited by selecting theMaterials Properties window. Click
Properties in the Analysis Liquid group box.
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Selections Description
Current Cell Conditions
[group box]

Displays the cell conditions of the analysis unit. These conditions are
based on the temperature of the cell and are used in computing the
analysis statistics displayed on theMaterial Properties window.

Select either fixed values or interpolated values based on the cell
temperature.

Fixed values. Enter a value in the Viscosity and Density fields.
These values will be maintained regardless of the cell temperature.

Interpolate using cell temperature. Enter three sets of values in
the Temp., Density, and Viscosity fields. These values will be used to
interpolate the density and viscosity at the current cell temperature.

The table requires that the entered values be properly ordered. For
example, enter values from left-to-right and from top-to-bottom.
Temperature is in ascending order.

Description [text box] If editing an existing file, this field contains the name of the selected
file. If defining a new file, enter a name in this field.

X-ray intensity [selec-
tion]

Normal. Optimized for most applications when using high X-ray
absorption liquids, such as water.

Low. Decreases intensity when using low X-ray absorption liquids,
such as hydrocarbons.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Liquid Properties

Liquid Properties
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4 Parameter Files

REPORT OPTIONS

File > Open > [.RPO File]
Or, click the Report Options tab when in Advanced option presentation.

About Reports on page 6 - 1

Additional reports are available using the Reportsmenu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.
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Selections Description
Distribution type
[selection]

Select the type of distribution data to report: Area, Number, or Mass.

Overlays [button] SeeOverlay Multiple Sample Files on page 6 - 10.

Reference [button] Specify a reference sample file to compare analysis results of the cur-
rent sample.

Report options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected reports
[group box]

Select the report names to include in the report.

Specification [button] Select the sample files to be used for the coarse and fine spe-
cification boundaries to determine if the results of the current sample
are within the specified boundaries.

Test [drop-down box] Select the analysis for the report: First, Last, or Average.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Report Options

Report Options
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5 PERFORM AN ANALYSIS

PREPARE FOR ANALYSIS
It is recommended to perform the tasks in the provided order.

CREATE SAMPLE FILES
File > New Sample > [.SMP File]

File > Open > [.SMP File]
Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation are selected from parameter files created in
the Advanced option presentation. The values specified in the parameter portions of the default
method are the defaults for new sample files. To navigate from one set of parameters to another,
select the parameter tab across the top of the window.

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Selections Description
Add Log Entry [button] Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] * Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Method [drop-down box] Select a method from the drop-down list.

Operator [text box] * Enter operator identification information.

Sample [text box] * Enter a sample description.

Submitter [text box] * Enter submitter identification information.

Sample Files

5 Perform an Analysis
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5 Perform an Analysis

Selections Description

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Sample Files (continued)

* This field label may have been renamed or may not display if modified inOptions > Default
Methods.

DRAIN AND LOAD OPERATION

Unit [n] > Drain and Load
Drain the System on page 9 - 22
Baseline Measurement on page 5 - 4

Before collecting baseline data or performing an analysis, the cell and mixing chamber must be
drained and the sample (or baseline liquid) loaded.

n Prior to a baseline collection or an analysis, go to Unit > Drain and Load.
n At the beginning of a baseline collection, select the Prepare SediGraph to load baseline liquid

check box on the Baseline Measurement window.
n At the beginning of an analysis, select the Prepare SediGraph to load sample check box on the

Ensure that the outlet tube is in the waste reservoir
and that the rinse tube is in the rinse liquid reservoir.

1. Select to either have the liquid remain in the mixing chamber or leave the mixing chamber
empty. Click Continue. A progress message appears prior to the following window.

2. Ensure the mixing chamber bezel is inserted in the mixing chamber, then load the sample
(or baseline liquid) into the mixing chamber. The mixing speed can be changed using the
Increase or Decrease button. Click Continue.
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3. Confirm the X-ray intensity reduction over the baseline before it completes:

n Good. Indicates reduction is between 30 and 75%meaning that the concentration level
is appropriate.

n Low. Indicates the reduction is less than 30%meaning that the concentration is too low
and sample should be added.

n High. Indicates the reduction is more than 75%meaning that the concentration is too
high and more dispersant or less sample should be used.

4. When the X-ray reduction level is set, click Continue and the cell will move to the normal
park position and the load operation will be complete.

Drain and Load Operation
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5 Perform an Analysis

BASELINE MEASUREMENT

Unit [n] > Baseline
A baseline measurement is required for data collection. Although it is not necessary to measure a
baseline for each analysis, Micromeritics recommends that a baseline measurement be
performed once per shift and when changing dispersing agents. Up to seven baselines can be
measured; however, only the last one may be saved.

Ensure that the outlet tube is in the waste container and that no sample is present in
the system.

1. If the baseline liquid has not been loaded into the mixing chamber:

a. Select Prepare to load baseline liquid.
b. Select to have the liquid remain in the mixing chamber or to leave the mixing chamber

empty.

If planning to use a liquid different from the one used for rinsing, select Leave mixing
chamber empty.

2. To have a baseline report generated, select Report After Analysis then select the report des-
tination.

3. Select the X-ray intensity setting.
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Selections Description
Baseline to use
[drop-down box]

Select whether to use the latest or the previous baseline

Latest. Uses the last baseline performed.

Previous. Uses the baseline which was active before the last series
of baselines were performed.

Prepare to load
baseline liquid
[check box]

Select if the baseline liquid is not loaded. Select if the liquid should
remain in the mixing chamber or leave the mixing chamber empty.

If Prepare to load background liquid is selected, a drain and load
operation is performed before the baseline measurement begins.
Load the baseline liquid when prompted. Click Next to begin the
baseline measurement.

If Prepare to load baseline liquid was selected, a drain and load
operation is performed first.

If this baseline is not satisfactory, click Next to perform another
baseline. If another baseline is measured, the current one will
become inaccessible.

X-ray intensity
[selection]

Normal. Increases intensity when using high X-ray absorption
liquids, such as water.

Low. Decreases intensity when using low X-ray absorption liquids,
such as hydrocarbons.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Baseline

Baseline Measurement
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5 Perform an Analysis

MASTERTECH AUTOMATIC
Unit[n] > MasterTech Automatic

Option is available only if a MasterTech is connected to the analyzer.

Use to analyze a series of samples of the same type, which contain the same analysis conditions.
Sample files are created automatically.

Selections Description
Method [drop-down box] Select the method to be used in the analysis. SeeMethods on

page 2 - 10.
Sample resuspension
[group box]

Enter resuspension parameters. All fields in this group box are
disabled if an analysis is in progress.

Samples tend to settle in the beaker while waiting for analysis,
especially if samples are prepared ahead of time, as in most cases
when using a MasterTech. Use the options in this group box to
program the MasterTech stirrer and probe to re-disperse the sample
before analysis.

Stirrer time. Enter the number of seconds to have the stirrer operate
during resuspension.

Stirrer speed. Select the stirrer speed. Coarse materials and less-
stable dispersions may require more high-speed stirring time than
finer materials.

MasterTech Automatic
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Selections Description
Probe time. Enter how long to have the ultrasonic probe operate
during resuspension. Coarse materials and less-stable dispersions
may require more probe time than finer materials.

Start with beaker
[text box]

Enter the position number of the beaker containing the first sample to
be analyzed. This field is disabled if an analysis is in progress.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

MasterTech Automatic (continued)

MasterTech Automatic
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5 Perform an Analysis

MASTERTECH SCHEDULE
Unit [n] > MasterTech Schedule

Option is available only if a MasterTech is connected to the analyzer.

Use to:

n Analyze a series of samples that may be different in size and shape and require different ana-
lysis conditions.

n Perform a series of baseline measurements.
n Analyze samples and measure a baseline alternately.

Selections Description
Insert [button] Click to insert sample files to be used for analyses.

MasterTech Schedule
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Selections Description
If a sample file is selected, the new file will be inserted before the
selected file; otherwise it will be inserted at the end of the list.

Beaker Number. Enter the beaker number containing the selected
sample (or baseline liquid).

Baseline measurement. Specify either a baseline measurement or
sample analysis for the specified beaker. If Baseline measurement is
selected, select the X-ray intensity.

n Normal. Increases intensity when using high X-ray absorption
liquids, such as water.

n Low. Decreases intensity when using low X-ray absorption
liquids, such as hydrocarbons.

Use this option if planning to change dispersing agents
with one of the samples. A baseline measurement can
then be scheduled using the beaker preceding the one
containing the different dispersant. For example, if plan-
ning to change dispersing liquids in beaker position #4,
schedule a baseline measurement in beaker position #3.

Sample analysis. Click Browse, then choose the sample file or use
with the sample in this beaker position.

n Stirrer time. The number of seconds to have the stirrer operate
during resuspension.

n Stirrer speed. Select the stirrer speed. Coarse materials and
less-stable dispersions may require more probe time than finer
materials.

n Probe time. The length of time to have the ultrasonic probe oper-
ate during resuspension. Coarse materials and less-stable dis-
persions may require more highspeed stirring time than finer
materials.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

MasterTech Schedule (continued)

MasterTech Schedule
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5 Perform an Analysis

1. Enter the position number of the beaker containing the current sample.
2. Select Baseline measurement or Sample analysis.

n If Sample analysis is selected, click Browse to select a sample file to use with the sample
in this beaker position. The values contained in the fields for Stirrer time, Stirrer speed, and
Probe time are copied from the selected sample file.

n If Baseline measurement is selected, select the X-ray intensity.
o Normal increases intensity when using high X-ray absorption liquids, such as water.
o Low decreases intensity when using low X-ray absorption liquids, such as hydro-
carbons.

3. ClickOK. The beaker information displays in the list box.
4. Repeat step 3 and 4 for each beaker containing sample.

If dispersing liquids will be changed at any time during this series, perform a baseline
measurement using the beaker position preceding the one containing the sample with the
new liquid. For example, if dispersing liquids are changed with the sample contained in
beaker position 4, insert a Baseline measurement for beaker position 3.

5. Click Report Settings to generate a report after analysis. ClickOK.
6. Click Start to begin the analysis.

When the analysis begins, the Start button changes to Stop. The Stop button
cancels the remaining analyses. The analysis that is currently in progress will be
completed.

To view the analyses in progress, go to View > Analysis Results.
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QUICK START ANALYSIS
Unit [n] > Quick Start
Use this mode of operation to analyze a series of samples of the same type that contain the same
analysis conditions. Sample files are created automatically.

Selections Description
Leave liquid in mixing chamber [button] Select to leave liquid in mixing chamber

after analysis.
Leave mixing chamber empty [button] Select to leave mixing chamber empty

after analysis.
Prepare SediGraph to load sample [button] Select if the sample is not loaded. If

selected, an initial drain and load oper-
ation is performed.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

QuickStart Analysis

1. If the analyzer has not been drained, select Prepare SediGraph to load sample to drain the
mixing chamber. Then select to have the liquid remain in the mixing chamber after the drain
and load operation or to leave the mixing chamber empty.

2. Click Report After Analysis to generate a report after analysis is complete.
3. Click Next.

Quick Start Analysis
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5 Perform an Analysis

4. Select aMethod from the drop-down list.
5. To specify a different file name enter the new file name in the text box.
6. Specify a mixing chamber speed using the Increase or Decrease buttons.
7. Load the sample.
8. Click Next. If Prepare SediGraph to load sample was selected, a drain is performed before

being prompted to load the first sample. Analysis of the first sample begins. The current
baseline and data display as they are collected. When analysis is complete, a prompt to
load the next sample displays. Repeat steps 7 and 8 until all analyses are complete.
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PERFORM A SAMPLE ANALYSIS
Unit [n] > Sample Analysis

1. Click New to create a new sample file, or click Browse to select an existing sample file.

Selections Description
Prepare SediGraph to
load sample [check box]

Select if the sample has not been loaded into the mixing chamber. If
selected, a drain and load operation is performed.

Select if the liquid should remain in the mixing chamber or leave the
mixing chamber empty.

Sample density
[text box]

Enter the sample density.

Number of tests
[text box]

Enter the number of tests to be performed.

Rinse after analysis
[check box]

Select to perform a rinse after analysis.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Sample Analysis

2. Click Start.
3. When the analysis completes, the graph displays.

Perform a Sample Analysis
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5 Perform an Analysis

4. Click the Report button to display the report.

5. Click Next to select another sample file for a new analysis.
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INITIALIZE MASTERTECH
Unit [n] > Initialize MasterTech

Select this option if:

n Manual operations should be performed with the MasterTech.
n The MasterTech beaker tray has been disturbed.

When the MasterTech is initialized, the tray is aligned so that beaker #1 is in the start position.

Initialize MasterTech
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5 Perform an Analysis

PERFORM A RINSE OPERATION

Unit [n] > Rinse > [SediGraph, MasterTech, Both]

n A rinse operation cannot be performed when an analysis is in progress.
n The rinse container should be rinsed thoroughly or replaced after each use.

A rinse operation should be performed to rinse the analysis cell, mixing chamber, and tubing of
any contaminants or sample materials from the previous analysis. It is best to perform a rinse
operation after each analysis. On the Analysis Options window, select that a rinse is to be
performed after an analysis. See Analysis Options on page 4 - 7.

Selections Description
SediGraph Rinses the analysis cell, mixing chamber, and the analyzer tubing.

MasterTech Rinses the MasterTech tubing.

Both Rinses the analysis cell, mixing chamber, the analyzer tubing, and
the MasterTech tubing.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Rinse
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SETUP THE RINSE AND WASTE CONTAINERS

1. Pour approximately 10 liters of water containing a small amount of surfactant into the rinse
container. For example, use 0.05% sodiummetaphosphate (W/W) in deionized water.

2. Insert the rinse tube into the rinse container.
3. Insert the waste and overflow tubes into the waste container.
4. Turn the caps clockwise to secure.

A. Rinse container
B. Tube weight
C. Rinse tube
D. Overflow tube
E. Waste tube
F. Waste container

Ensure that tube weights are attached to the rinse and waste tubes, that the overflow
tube and waste tubes are in the waste container, and that the rinse tube is in the rinse
liquid container.

Setup the Rinse andWaste Containers
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5 Perform an Analysis

RINSE SEDIGRAPH

Unit [n] > Rinse > SediGraph

Selections Description
Rinse Cycles [selection] Autorinse. Performs up to 3 cycles of 3 rinses each (a total of 9

rinses) in an attempt to reestablish baseline conditions. If conditions
are not reestablished after nine rinses, an error message is
displayed. See Autorinse on page 2 - 15.

Rinses. Specifies up to five rinses to be performed.
Cell Pump Speed
[text box]

The speed for the cell pump is to operate during rinsing. The range is
1 to 5, with 1 being the slowest.

Continue [button] Begins the rinse operation. A message displays indicating a rinse
operation is in progress. When rinsing is complete, the window
closes.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

SediGraph Rinse

1. Ensure the rinse and waste containers have been setup. See Setup the Rinse and Waste
Containers on the previous page.

2. Select either of the following:

n Autorinse. To have the analyzer automatically determine how many rinse cycles to per-
form. Autorinse, in an effort to reestablish baseline conditions, performs three cycles of
three rinses per cycle (default setting) before displaying an error message that baseline
conditions cannot be reestablished.

n Rinses. If Rinses is selected, enter the number of rinse cycles to perform.
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3. Enter the operating speed of the cell pump. A speed of 2 usually is sufficient unless the
material is difficult to rinse; then it may be necessary to use a higher speed.

4. Click Continue. Progress messages display until rinsing is complete.

RINSE MASTERTECH

Unit [n] > Rinse > MasterTech

Selections Description
Continue [button] Begins the rinse operation. A message displays indic-

ating a rinse operation is in progress. When rinsing is
complete, the window closes.

Rinse beaker number [text box] Enter the position number of the beaker to rinse into.
Ensure the beaker is empty.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

MasterTech Rinse

1. Ensure the rinse and waste containers have been setup. See Setup the Rinse and Waste
Containers on page 5 - 17.

2. Enter the position number of the beaker to catch the rinse liquid.
3. Ensure the beaker is empty.
4. Click Continue. Progress messages display until rinsing is complete.

Rinse MasterTech
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5 Perform an Analysis

RINSE > BOTH

Unit [n] > Rinse > Both

1. Ensure the rinse and waste containers have been setup. See Setup the Rinse and Waste
Containers on page 5 - 17.

2. In the SediGraph group box, select:
n Autorinse. To have the analyzer automatically determine how many rinse cycles to per-

form. Autorinse, in an effort to reestablish baseline conditions, performs three cycles of
three rinses per cycle (default setting) before displaying an error message that baseline
conditions cannot be reestablished.

n Rinses. Enter the number of rinse cycles to perform.
3. In the MasterTech group box, enter the position number of the beaker to catch the rinse

liquid.
4. Enter a speed in the Cell pump speed field.
5. Ensure the beaker is empty.
6. Click Continue. Progress messages display until rinsing is complete.
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PERFORM A REFERENCE MATERIAL ANALYSIS
A reference material analysis is used to verify the analyzer is operating properly and producing
optimum results. These methods provide specifications for critical report quantities and reporting
of whether quantities are in or out of specification.

When running a reference material analysis, use the appropriate reference material kit. This kit is
available from Micromeritics. The results should match those shown on the label of the reference
material bottle, within the tolerance level.

Parts and accessories are located on the Micromeritics web page.

Perform a Reference Material Analysis
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5 Perform an Analysis

ADVANCED OPTIONS

Options > Advanced Options

Changing these parameters will affect the performance of the SediGraph III Plus
instrument. This program should only be used after consultation with a Micromeritics
Service Representative

BASELINE/FULLSCALE
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CELL PROFILING

Cell Profiling is the appropriate choice for particle systems that are readily suspended, such as
most pigments and clays. Readily suspended samples would be characterized by particle
populations mostly below 50 micrometers and having a moderate density less than 4 g/cm3).

Cell Profiling uses baseline and full scale readings taken at each cell position to scale mass
percent data taken at that position. This prevents cell window defects or contamination from
affecting the measured size distribution.

BASELINE/FULLSCALE AVERAGING

Baseline/Fullscale Averaging is a choice provided for the analysis of samples having a significant
mass percentage of particles showing a very high setting velocity because of some combination of
size (50 to 300 micrometers) or density.

Baseline/Fullscale Averaging uses mean baseline and fullscale values to scale mass percent data
taken at all cell positions. This procedure largely eliminates the fullscale fluctuations caused by
flow variations in the presence of a statistically small number population of the more massive
particles. When using this choice, the cell should be checked to verify a flat baseline.

HIGH SPEED ANALYSIS

Advanced Options
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5 Perform an Analysis

NORMAL MODE

Normal Mode provides an adjusted cell position schedule that ensures a consistent resolution of
the sedimentation profile for an abbreviated high speed analysis. This increase in accuracy comes
at the cost of an approximately 10 minute increase in runtime compared to an abbreviated high
speed Control Mode run.

CONTROL MODE

Control Mode is provided to obtain the fastest possible results when specifying an ending
diameter greater than 0.2 micrometers (an abbreviated run). Because the short analysis time
does not allow full resolution of the particle sedimentation profile, the results obtained, while
consistent, may not exactly agree with a full range analysis.

Abbreviated runs in Control Mode should not be used to check final product quality without
investigating its effect for the materials being used. Select of Control Mode has no effect on full
range analyses, whether high speed, standard, or high resolution.
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6 ABOUT REPORTS
Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.

Reports > Start Report
Generates a report on a sample analysis.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

Reports > Open SPC Report
Opens the file selector to open or create an SPC report. See SPC Report on page 6 - 3.

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
either Complete or Analyzing.

6 About Reports
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6 About Reports

BASELINE REPORT
Reports > Baseline
A graphical report can be generated on an instrument’s baseline. This report generates a graph
illustrating the X-ray intensity versus the cell height. The report header contains baseline
statistics, such as the unit serial number, date the baseline was performed, etc.

Selections Description
Baseline Date and Time Date and time of the last baseline measurement.

Copies [scroll selection] Specifies the number of copies of the report.

Instrument
[drop-down box]

List of serial numbers of the attached instruments.

File [text box] Specifies the location where the report should be saved.

File name [text box] Specifies the name for the report.

File type
[drop-down box]

Indicates the report file type: Spreadsheet (.xls), XML (.xml) or
Unicode Text (.txt).

Preview [button] Displays a preview of the report.

Print [button] Prints the selected report.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Baseline Report
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SPC REPORT
Reports > SPC Report Options
Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more
efficient to select only the necessary variables.

SPC Report

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 6 - 3



6 About Reports

MICROACTIVE REPORTS
MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easy way to investigate and manipulate analysis data using a variety of
reporting methods.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters are also displayed. Plots may be edited by selecting the data points or data point
range to be included in the plots and modifying the parameters. When a report is edited, the
results are immediately reflected in the plots and summary data.
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INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. From the view selector drop-down list at the bottom of the window, do either of the following:
n Change the option presentation of the sample description window to either Basic or

Advanced to modify certain file parameters.
n Select another plot from the list and edit the data contained in the plot.

2. When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:
n Drag the blue bars to increase or decrease the range of data included in the plot.
n Right-click to display a popup menu to include reports; enable or select overlays; edit

curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

3. Click Save.

Interactive Reports
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6 About Reports

REPORT FEATURES
Report Style on page 2 - 17

Click Preview on the MicroActive report window to display additional report information.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the

axes.
n All reports contain a header displaying file statistics.
n Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-

time, analysis conditions, etc.
n The headers contain notes of sample file changes occurring after analysis.
n Summary report headers contain the same information as tabular and graphical reports with

the exception of notes.

A. Data display (graph or
text)

B. Report header area
C. Report export options
D. Generated tabs
E. Report graphic
F. Title
G. Print icon
H. Style icon

Selections Description
Data Display area Displays either a graphic or text from the generated report. Click the

tabs across the top to display the selected report.
Generated tabs Tabs represent the reports selected on the Report Options window.

Print icon Click to send the report to a designated printer.

Report Features and Shortcuts
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Selections Description
Report export options Select a file format option for the exported report details.

Report graphic A graphic can be displayed on the report by using the Style button.

Report header area Displays information about the sample, instrument, and software.

Title A report title can be displayed on the report by using the Style but-
ton.

Style icon Click to customize report options, such as font size, graphics, report
title, etc.

Report Features and Shortcuts (continued)

Report Features
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6 About Reports

REPORT SHORTCUTS
Right-click in the graphic or tabular report area to display report shortcuts.

Selections Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy data Copies the report data to the clipboard. It can then be pasted into
other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Copy plot Copies the graph to the clipboard. It can then be pasted into other
software programs.

Copy table Copies the table to the clipboard.

Edit curve Edits available curves from the report.

Reset axis limits to ini-
tial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Set scaling options Edits the axis properties.

Linear / Logarithmic. [button] Select the option to scale the graph
as linear or logarithmic.

Autoscale minimum / maximum. [check box] To manually specify
minimum / maximum autoscale, deselect the option and enter the
new amount in the text box.

Report Shortcuts
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Selections Description
Show Gridlines. [check box] Use to enable or disable report
gridlines.

Invert scale. [check box] Use to invert the scale.
Show curve Displays a list of all curves. Select the curve(s) to display.

Show legend Displays or hides the legend.

Report Shortcuts (continued)

AXIS CROSS-HAIR
Left-click on the graph to view the cross-hair coordinates.

Example of
Axis cross-hair feature

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal
view, right-click in the graph and select Autoscale all axes.

Report Features
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6 About Reports

OVERLAY MULTIPLE SAMPLE FILES
To overlay the same type of graph on multiple samples:

1. Go to File > Open.
2. Select a .SMP file, then clickOpen. If the particle size plot displays, select Advanced from

the view selector drop-down list at the bottom of the window to display the tabbed window
view.

3. Click the Report Options tab.
4. In the Selected Reports list box, highlight a report, then clickOverlays.

5. In the Plot Overlay Sample Selection window, move up to 25 files from the Available Files
box to the Selected Files box.

Selections Description
Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then click Add. The selected files are moved to the Selected
Files list box.

Look in [button] Changes the file folder location. Click the Browse icon.

Reference [button] Compares analysis results for the current sample to those obtained
for a reference sample. Results are shown in the Difference from
Reference Graph report.

Selected Files
[selection]

Lists the files selected to be combined. Click Remove to move a file
back to the Available Files list box. ClickOK to combine the files.

Overlay Sample Selection

6 - 10 SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022



Selections Description
Specification [button] Determines if the results for the current sample are within coarse and

fine specifications. Results are shown in theOut of Specification
Graph report.

Status [drop-down box] Selects the status of files to be combined.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Overlay Sample Selection (continued)

6. ClickOK.
7. Click Preview.

Overlay Multiple Sample Files
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6 About Reports

REPORT EXAMPLES

BASELINE REPORT
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COMBINED REPORT

Combined Report
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6 About Reports

CUMULATIVE FINER MASS PERCENT VS DIAMETER
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MASS FREQUENCY VS DIAMETER REPORT

Mass Frequency vs Diameter Report
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7 SELECTED REPORT OPTIONS

To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

ADVANCED REPORTS - PYTHON MODULE

The mic Python module is automatically imported when running a user supplied script. The
module provides access to particle size data, and provides support for summary, tabular, and
graphical reports.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

7 Selected Report Options
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7 Selected Report Options

Advanced Report Options

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 30 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. On the Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.
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Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Advanced Reports

Advanced Reports - Python Module
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7 Selected Report Options

BASELINE OPTIONS REPORT

The Baseline report shows a baseline measurement of the x-ray intensity as a function of cell
elevator position.

Select the options to include in the Baseline report.
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COMBINED REPORT

The Combined report combines a selection of any SediGraph report onto a single page.

Combined Report

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 7 - 5



7 Selected Report Options

CUMULATIVE TABLE

This tabular report shows the SediGraph's collected data interpolated to a user specified set of
cumulative values rather than being reported at the instrument defined standard particle sizes.
Select which quantities to show in each column of the table.

Cumulative Percent Table

If Percent is selected inOptions > Units, then the Cumulative Percent Table is available.

Cumulative Fraction Table

If Percent is selected inOptions > Units, then the Cumulative Fraction Table is available.
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GRAPH OPTIONS

n Cumulative Graph Options
n Frequency Graph
n Difference from Ref Graph
n Out of Spec
n Surface Area
n Surface Area Population Options
n Number
n Number Population

Graph Options
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7 Selected Report Options

LOG PROBABILITY REPORT

The Log Probability report plots the particle size distribution with particle size on the x-axis and the
logarithm of the probability on the y-axis
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PARTICLE SIZE TABLE

Cumulative Table on page 7 - 6

This tabular report shows the SediGraph's collected data interpolated to a user specified set of
particle sizes rather than being reported at the instrument defined standard particle sizes. Select
which quantities to show in each column of the table.

Particle Size Table
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7 Selected Report Options

ROSIN RAMMLER

The Rosin Rammler report cannot be edited.

This report shows the sample's particle distribution using a graph of the Rosin Rammler
parameter as a function of the particle diameter.

SAMPLE LOG REPORT

Sample Log reports cannot be edited.

Inserts a log of sample operations in the reports.

This report provides information on:

n Manual control operations performed during analysis.
n Information entered using Add Log Entry on the sample file editor.
n Warnings and/or errors which occurred during analysis.
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STANDARD CLASS SIZE TABLE REPORT

This tabular report shows the SediGraph's collected data measured at the instrument defined
standard set of particle sizes. Select which quantities to show in each column of the table.

Standard Class Size Table Report
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7 Selected Report Options

STANDARD SIEVE TABLE

This tabular report shows the SediGraph's collected data interpolated to a set of standard sieves
rather than reported at the instrument defined standard particle sizes. Select which quantities to
show in each column of the table.
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SUMMARY REPORT OPTIONS

The Summary report allows the user to select relevant statistical measures to characterize the
sample and show these results on a single report page.

Summary Report Options
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8 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start diagnostic tests, and open saved diagnostic reports.
Each test generates a file to the default directory name and path of ...\...\Service\userdiag unless
another directory name was specified. These reports can be sent to a Micromeritics Service
Representative for examination.

SAVE FILES FOR PROBLEM DIAGNOSIS
Unit [n] > Diagnostics > Save Files for Problem Diagnosis
Use to compress pertinent diagnostic information into a single zip file. This file can be sent to a
Micromeritics Service Representative for problem resolution.

1. Complete the form. A default file named Diagnostics-[date].zip is created unless another file
name is specified.

2. Add any files that are related to the problem— such as sample files — and save the file.
3. Send an email to Service.Helpdesk@Micromeritics.com for instructions on how to transfer

the .ZIP files to Micromeritics.

Selections Description
Problem description
[text box]

Enter information that would be helpful to the Micromeritics rep-
resentative.

Include Files Add. Click to select additional files to send with this problem
diagnosis.

Delete. Select the file in the Include Files box, then click Delete to
remove the file from the list.

Clear. Click to clear all files from the Include Files box.

Save Files for Problem Diagnostics

8 Diagnostics
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8 Diagnostics

Selections Description
Save As [button] Click to specify the name and location of the compressed file. Make a

note of the file name and location. This file will need to be sent to
your Micromeritics representative for problem resolution.

Micromeritics
representative [text box]

Enter the name of your Micromeritics representative. This inform-
ation will remain on the window each time files for problem diagnosis
need to be submitted (can be modified as necessary).

User Information
[text box]

Enter information for the person to be contacted by a Micromeritics
representative. This information will remain on the window each time
files for problem diagnosis need to be submitted (can be modified as
necessary).

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Save Files for Problem Diagnostics (continued)
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9 MAINTENANCE AND TROUBLESHOOTING

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the MSDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

When lifting or relocating the instrument, use proper lifting and transporting devices for
heavy instruments. Ensure that sufficient personnel are available to assist in moving
the instrument. The 5125 SediGraph II Plus weighs approximately 43 kg (95 lb). The
MasterTech weighs approximately 18 kg (40 lb).

Use of a power cord or power supply not provided with the instrument could cause
personal injury or damage to the equipment. If a replacement is needed, contact your
Micromeritics Service Representative. Detachable power supply cords with an
inadequate rating could cause significant instrument damage or physical harm.

Do not add anything between the power cord and the power source that would
compromise the earth ground.

Do not remove or disable the grounding prong on the instrument power cord.

If the equipment needs to be relocated, check with your Micromeritics service
representative. The equipment must be positioned such that the mains supply is not
obstructed and is easily accessible to disconnect the equipment from the AC main
power supply.

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.Micromeritics.com).
n Error Messages document (PDF)
n Parts and Accessories

9 Maintenance and Troubleshooting
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9 Maintenance and Troubleshooting

Most operational problems are caused by:
n Deteriorated or blocked tubing
n Air leaks
n An unlevel analyzer

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided
below:

Cell cannot be filled or drained.

Cause A: Blocked or damaged tubing.

Action A: Locate and replace blocked or damaged tubing. See Replace the Flexible Tubing
on page 9 - 18.

Cause B: Blocked cell input or output port.

Action B: Clean analysis cell. See Replace the Analysis Cell Assembly on page 9 - 9.
Cause C: Valve or pump not working properly.

Action C: FromManual Control window, check pump and valve operation. If either is not work-
ing properly, contact authorized service personnel.

Cause D: Tubing improperly installed.

Action D: Install the tubing. See Replace the Flexible Tubing on page 9 - 18.

Cell cannot be raised or lowered

Cause: Elevator which moves cell is stuck.

Action: Check flexible tubing for possible obstruction to elevator movement. If necessary,
reposition tubing. Also check for any other obstruction to elevator movement.

Mixing chamber cannot be filled or drained.

Cause A: Blocked or damaged tubing.

Action A: Locate and replace blocked or damaged tubing. See Replace the Flexible Tubing
on page 9 - 18.

Cause B: Blocked mixing chamber input or output port.

Action B: Clean mixing chamber. See Clean the Mixing Chamber and Bezel on page 9 -
17.

Cause C: Valve or pump not working properly.

Action C: FromManual Control window, check pump and valve operation. If either is not work-
ing properly, contact authorized service personnel.
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Cause D: Tubing improperly installed.

Action D: Install the tubing. See Replace the Flexible Tubing on page 9 - 18.

Mixing chamber suspension is turning brown

Cause: Teflon coating on stirring bar is worn.

Action: Replace stirring bar.

X-RAY ON indicator is turned on, but the computer display shows 0 kilocounts.

Cause A: Analysis compartment door not completely closed.

Action A: Close analysis compartment door.

Cause B: Cell is in a position which blocks beam.

Action B: Move cell to proper operating position. Enable Manual Control, access the pop-up
menu on the cell, and select Move Cell Position.

Cause C: Cell is clogged.

Action C: Remove and clean cell. See Clean the Analysis Cell Assembly on page 9 - 11.
Cause D: Slits in collimator blocked.

Action D: Clean the collimator. See Clean the Collimator Slits on page 9 - 14.
Cause E: X-ray source or detector has failed.

Action E: Contact authorized service personnel.

X-RAY STANDBY indicator was turned on, but when keyswitch is placed in X-RAY
ON position, XRAY ON indicator does not turn on.

Cause A: Keyswitch is between positions.

Action A: Move keyswitch to X-RAY STANDBY position and then back to X-RAY ON position
while observing indicator.

Cause B: X-RAY ON indicator lamp is burned out.

Action B: Replace lamp. See Replace the X-ray Indicator Lamps on page 9 - 23.
Cause C: X-ray filament supply not available or X-ray unit damaged.

Action C: Contact authorized service personnel in accordance with service contract.

Cause D: Rear panel is off, the top cover is off, or the fluid module is not fully installed.

Action D: Replace all panels.

See Cause of Bubbles on page 9 - 27 first to determine the cause of the bubbles. Perform the

9 Maintenance and Troubleshooting
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9 Maintenance and Troubleshooting

outlined procedure then return to this table for corrective action.

Bubble elimination problem.

Cause A: Windows are dirty or misaligned.

Action A: Clean or replace the windows.See Clean the Analysis Cell Assembly on page 9
- 11.

Cause B: Inlet port on the cell assembly is loose.

Action B: Replace the cell assembly. See Replace the Analysis Cell Assembly on page 9
- 9.

Cause C: A valve has failed.

Action C: Contact authorized service personnel.
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SAFE SERVICING

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

To ensure safe servicing and continued safety of the instrument after servicing, service personnel
should be aware of the following risks:

Product specific risks that may affect service personnel:
n Electrical. Servicing or repair could require opening the outer panels and exposing ener-

gized electrical components.
n MasterTech Fuses. Only use fuses rated as:

Power Source Required Fuses
100-120VAC Single fuse, 3AG (Slo-Blo) 250V, 2.0AL, 6.35 mm x 31.7 5

mm. Single pole input.
220-240VAC Double fuse, Time-lag (Slo-Blo), 250V, 1.25AL, 5 mm x 20

mm. Double pole input.

Protective measures for these risks:
n Electrical. The electrical components operate at low voltage (24V or less) and pose low risk

when energized. Maintenance, troubleshooting, and repairs should be performed with the
instrument de-energized whenever possible, in accordance with standard electrical safety
guidelines.

n MasterTech Fuses. Use of improperly rated fuses could cause damage to the equipment.
n Power off and unplug the analyzer from the power outlet prior to servicing.

Verification of the safe state of the instrument after repair:
n All instrument panels and covers installed.

PARTS AND ACCESSORIES
Parts and accessories are located on the Micromeritics web page.

Safe Servicing
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9 Maintenance and Troubleshooting

POWER

The SediGraph is designed to operate with universal input power supply (100/120/220/240 VAC,
47/63 Hz, 450 VA). The power outlet should be able to supply 15 amps@ 100 or 115 VAC ±10%
or 7.5 amps@ 240 VAC ±10%. These requirements can be checked by using a circuit analyzer
(available at most hardware or electronic supply houses) or a multimeter. There should also be
sufficient outlets for the computer, monitor, printer, and any other peripheral devices. The power
cord, IEC, 300V, 10A (available in the accessories kit) should be connected to noise-free power of
the correct voltage and frequency, with a safety earth ground, through a standard wall receptacle.

The MasterTech 052 leaves the factory set for 120 VAC and with the line fuse removed. The
correct setting of the universal power entrance must be checked, and the appropriate fuse
installed before the MasterTech can be operated. The MasterTech is designed to operate with
either 100/120/220/240 VAC at 50/ 60 Hz. Voltage selection and fusing are made at the power
connector which is located on the rear panel of the unit.

The instrument should be connected to a switch which meets relevant requirements of IEC
60947-3 or a circuit breaker which meets the relevant requirements of IEC 60947-2.

Noise-free power of the correct voltage and frequency, with a safety earth ground, should be
available through a standard wall receptacle. There should be a minimum 15A rated breaker
@ 100/120 VAC and a minimum 7.5A@ 240 VAC.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the specifications stated above.
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ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

Show Instrument Schematic on page 2 - 20

Use to enable the manual control of certain system valves and pump components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left of Unit [n] > Enable
Manual Control. If the analyzer schematic is not immediately visible, go to Unit [n] > Show
Instrument Schematic.

Enable Manual Control
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9 Maintenance and Troubleshooting

PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

A Micromeritics service technician should perform the following procedures every 12 months. Do
not attempt to perform these procedures yourself.

n Clean the high voltage area
n Calibrate the X-ray control system
n Calibrate the fluid control system
n Calibrate the temperature control system

Maintenance Required Frequency
Perform a reference material run Every week

Clean the analyzer Every 30 days*

Clean the mixing chamber and bezel As needed

Clean the analysis cell Every 30 days*

Replace the mixing pump and cell pump tubing Every 30 days*

Replace the analysis cell tubing As needed

Clean the air filter Every 30 days*

Check the operation of the mixing pump Every 30 days*

Check the operation of the cell pump Every 30 days*

Check the level of the analyzer Every 30 days*

Clean the collimating slits As needed

* Or every 160 analyses, which ever comes first
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ANALYSIS CELL ASSEMBLY

Replace the Analysis Cell Assembly

If the analysis cell assembly becomes damaged, it may be necessary to replace it.

1. Go to Unit [n] > Drain and Load.
2. Select Leave mixing chamber empty.
3. Click Continue.
4. When prompted to load the sample, click Cancel.
5. Power OFF the Pump Control.
6. Open the transparent sliding door to the analysis compartment.
7. Loosen the cell mounting screw and remove the cell from the retaining bracket.

A. Flexible analysis cell tubing

8. Carefully remove the flexible tubing from the two ports on the cell.

9. Connect the flexible tubing to the ports on the new analysis cell
10. Insert the cell in the retaining bracket and tighten the cell mounting screw.
11. Power ON the Pump Control.

Analysis Cell Assembly
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9 Maintenance and Troubleshooting

Replace the Analysis Cell Tubing

1. Drain the system. See Drain the System on page 9 - 22.
2. Place the Pump Control switch on the analyzer front panel in the OFF position
3. Open the transparent sliding door to the analysis compartment.

A. Flexible analysis cell tubing
B. Back connector (for back cell port tubing)
C. Front connector (for front cell port tubing)

4. Remove the flexible analysis cell tubing from the rigid tubing connector in the analysis com-
partment.

5. Loosen the cell mounting screw and remove the cell from the retaining bracket as shown
below.

A. Flexible analysis cell tubing

6. Remove the flexible analysis cell tubing from the two ports on the cell.
7. Connect the new flexible analysis cell tubing to the ports on the new analysis cell and to the

rigid tubing connector. The tubing for the front port of the cell connects to the front rigid
tubing connector and the tubing for back port of the cell connects to the back rigid tubing
connector.
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8. Insert the cell in the retaining bracket and tighten the cell mounting screw.
9. Close the analysis compartment door.
10. Power ON the Pump Control.

Clean the Analysis Cell Assembly

The analysis cell should be removed periodically and cleaned to remove any residue.

1. Go to Unit [n] > Drain and Load.
2. Select Leave mixing chamber empty.
3. Click Continue.
4. When prompted to load the sample, click Cancel.
5. Place the Pump Control switch on the analyzer front panel in the OFF position.
6. Open the transparent sliding door to the analysis compartment. Loosen the cell mounting

screw and remove the cell from the retaining bracket.

A. Flexible analysis cell tubing

7. Carefully remove the flexible tubing from the rigid tubing connector which is mounted along
the right side of the analysis compartment.

8. Carefully remove the flexible tubing from the two ports on the cell.

9. Disassemble the cell by removing the ten screws in the cell window retaining plates.

Analysis Cell Assembly
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9 Maintenance and Troubleshooting

Do not use cloth made of a coarse material or abrasive cleansers when cleaning the
cell windows. Particles may lodge in scratches, which could alter X-ray pulse rates
and cause invalid analysis results.

10. Use either IPA or a mild detergent to clean the cell windows. Use an air blower to remove
any debris from the cell body, window retaining plates, and ports.

11. Assemble the cell by placing a cell window and a cell window retaining plate on each side of
the cell body. The cell window retaining plate must be positioned so that the sloped part
matches that of the cell body and other plate.

Ensure the sloped portions of the cell body and retaining
plates are aligned.

12. Insert the ten screws removed in step 8 into the window retaining plates, but do not tighten.

When assembling the cell, alternate the tightening of screws. Failure to do so could
result in air entering the cell, causing bubble elimination problems.

13. Using a screwdriver, tighten the screws around the cell by tightening one screw and then
tightening the screw diagonally opposite that screw. See the following illustration for the
tightening sequence. This sequence helps to ensure uniform closure around the cell.
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14. Connect the flexible tubing to the ports on the analysis cell and to the rigid tubing connector.
The tubing for the front port of the cell connects to the front rigid tubing connector. The
tubing for the back port of the cell connects to the back rigid tubing connector.

15. Insert the cell in the retaining bracket and tighten the cell mounting screw.
16. Place the Pump Control switch in the ON position.
17. Go to Unit [n] > Rinse > SediGraph.

18. Select Autorinse then click Continue to rinse the analysis cell.

Analysis Cell Assembly
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9 Maintenance and Troubleshooting

CLEAN THE COLLIMATOR SLITS

Replace the Analysis Cell Assembly on page 9 - 9

The collimator slits may become blocked by dust or debris which accumulates in the analysis
compartment over a period of time, causing inaccurate results.

1. Power OFF the analyzer.
2. Remove the retaining screws from the top of the analyzer; then remove the top panel.
3. Remove the analysis cell. See Replace the Analysis Cell Assembly on page 9 - 9 for

removal instructions.
4. Remove the two foam plugs in the top of the analysis module.
5. Use a hex driver with an extension to remove the collimator retaining screws.
6. Reach through the door of the analysis compartment to lift the top collimator out of the

analysis module.

A. Foam plugs
B. Collimator retaining screws

7. Use a lint-free cloth to clean the shiny area near the center of the collimator removed and
the corresponding area of the collimator remaining in the analysis module.

Do not use cloth made of a coarse material or abrasive cleansers when cleaning the
collimating slits.
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8. Replace the top collimator and the retaining screws.

Tighten the collimator retaining screws only enough to securely hold the collimator in
place. Over-tightening the screws can close the collimating slits, reducing the intensity
of (or completely blocking) the X-rays.

9. Tighten the retaining screws for the top collimator.
10. Replace the two foam plugs in the top of the analysis module.
11. Replace the analysis cell and the top panel.
12. Power ON the analyzer.

Clean the Collimator Slits
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9 Maintenance and Troubleshooting

CLEAN THE AIR FILTER

The air filter on the analyzer should be cleaned every 30 days (more often in environments with
increased levels of dust) and replaced once a year.

1. Slide out the drip tray on the front of the analyzer.

A. Air filter
B. Drip tray

2. Remove the air filter from drip tray by squeezing the filter while pulling it away from the drip
tray.

3. Rinse the filter thoroughly and shake out the excess water. Place it aside and allow it to dry.
4. Install a new filter or after the filter has dried, replace it.
5. Check to see that the analyzer is level.
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CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning. If a
MasterTech is installed, clean it in the same manner.

n Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in
damage to the unit.

n Use only a mild detergent in water to clean safety shields. The use of isopropyl
alcohol can damage the shield surface.

CLEAN THE MIXING CHAMBER AND BEZEL

The mixing chamber bezel should be cleaned periodically to prevent contaminants from entering
the mixing chamber. To clean the bezel:

n Remove the bezel and clean using a mild detergent. Rinse, then dry thoroughly before
replacing it on the mixing chamber.

The mixing chamber should be removed and cleaned periodically to remove any residue.

When cleaning the mixing chamber, avoid getting the electrical connections wet. Do
not immerse the chamber in liquid. Doing so could damage the system.

1. Drain the mixing chamber.

a. Go to Unit [n] > Drain and Load.
b. Select Leave mixing chamber empty.
c. Click Continue.
d. When prompted to load the sample, click Cancel.

2. Disconnect the flexible tubing from the mixing chamber, exercising caution to prevent dam-
age to the tubing.

3. Disconnect the electrical cable.

Clean the Instrument
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9 Maintenance and Troubleshooting

A. Flexible tubing
B. Flexible tubing
C. Flexible tubing
D. Flexible tubing
E. Flexible tubing
F. Electrical cable

4. Clean the chamber using IPA or a mild detergent. Rinse thoroughly. All ports should be
cleaned using an air blower.

5. Reconnect the tubing to the mixing chamber.
6. To reconnect the mixing chamber, ensure the tubing is securely fastened at each port.
7. Reconnect the electrical cable.

REPLACE THE FLEXIBLE TUBING

Drain and Load Operation on page 5 - 2

The analyzer includes a complete plumbing system for circulation of sedimentation liquid and
particle suspension between the cell, the mixing chamber, an external rinse container, and an
external waste container. In order for the system to operate properly, damaged or deteriorated
tubing must be replaced. Tubing from the mixing pump, the cell pump, and the analysis cell can be
replaced independently.

Use the tube installation tool to help install the tubing. It is included in the tool
accessories kit.

When replacing tubing, always drain the system first.
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CHECK THE MIXING PUMP OPERATION

The mixing pump should be checked every 30 days (or every 160 runs, whichever comes first) to
see if it is operating correctly.

1. Go to Unit [n] > Enable Manual Control to display the instrument schematic.
2. Right-click theMixing Pump icon, then select Turn on from the pop-up menu.

A. MasterTech pump
B. Mixing pump
C. Mixing chamber
D. Cell pump
E. Analysis cell
F. MasterTech arm
G. MasterTech stirrer
H. MasterTech Beaker

Items in the red box show only if
MasterTech is installed

3. If the pump fails to start, refer to the Reset the Mixing Pump and Cell Pump on page 9 -
21.

4. Right-click on theMixing Pump icon.
5. Select Turn off from the pop-up. If the pump fails to stop, the fluid control board may need

replacing. Contact your service representative.

Check the Mixing Pump Operation
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9 Maintenance and Troubleshooting

CHECK THE CELL PUMP OPERATION

Reset the Mixing Pump and Cell Pump on the facing page

The cell pump should be checked every 30 days (or every 160 runs, whichever comes first) to see
if it is operating correctly.

1. Go to Unit [n] > Enable Manual Control to display the instrument schematic.
2. Right-click the Cell Pump icon, then select Turn on from the pop-up.

A. MasterTech pump
B. Mixing pump
C. Mixing chamber
D. Cell pump
E. Analysis cell
F. MasterTech arm
G. MasterTech stirrer
H. MasterTech Beaker

Items in the red box show only if
MasterTech is installed

3. Perform the following steps. If any of these steps fail, seeReset the Mixing Pump and Cell
Pump on the facing page .

For each of the following steps, right-click the Cell Pump icon, then select the item listed:

n Increase speed
n Decrease speed
n Flow up in cell
n Flow down in cell
n Increase speed
n Decrease speed

4. Right-click the Cell Pump icon, then select Turn off. If the pump fails to stop, the fluid
control board may need replacing. Contact a service representative.
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RESET THE MIXING PUMP AND CELL PUMP

If an electrical overload occurs with the mixing pump or the cell pump, the pumps should be rest.

1. Power OFF the Pump Control.
2. Allow the internal varistor to cool down (approximately two to three minutes).
3. Check the tubing to verify that it is routed properly.
4. Place the Pump Control switch in the AUTO position.
5. Check the pump operation.

Contact your Micromeritics service representative if the problem continues.

REPLACE THE CELL WINDOWS

Clean the Analysis Cell Assembly on page 9 - 11

X-ray photons from the X-ray source pass through the cell windows to the X-ray detector on the
other side of the cell. If cell windows become scratched or damaged, settling particles may
become entrapped. This could alter X-ray pulses, resulting in invalid analyses. The analysis cell
windows should be replaced when necessary.

Reset the Mixing Pump and Cell Pump
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9 Maintenance and Troubleshooting

DRAIN THE SYSTEM

Unit [n] > Drain and Load
Drain and Load Operation on page 5 - 2

Ensure that the outlet tube is in the waste reservoir and the rinse tube is in the rinse liquid
reservoir.

1. Select Leave mixing chamber empty.
2. Click Continue. A progress message displays.
3. Click Cancel.

CHECK THE LEVEL OF THE ANALYZER

An unlevel analyzer may cause inaccurate analyses. Check every 30 days to see if the analyzer is
level.

1. Open the analysis compartment door and locate the level indicator.
2. Look straight down at the indicator. The analyzer is level when the bubble is centered inside

the black circle on the level indicator.

Level indicator

3. If the analyzer is not level, lift the corner of the analyzer then turn the appropriate foot
counterclockwise to raise the unit or clockwise to lower the unit.

4. Set the analyzer down and observe the indicator. The bubble should be centered inside the
black circle on the level indicator.
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REPLACE THE X-RAY INDICATOR LAMPS

The X-RAY STANDBY indicator and the X-RAY ON indicator on the front panel of the analyzer
contain an internal lamp.

If the X-RAY ON indicator lamp is burned out or installed incorrectly, the instrument
will be inoperative.

Disconnect the analyzer power cord from the AC power source before attempting to
replace the lamp. Failure to do so could result in electrical shock or damage to the
instrument.

1. Remove the cover lens from the analyzer by prying with a flat object.

2. Using a flat object, pull the lever which raises the lamp socket out of the lamp compartment.

3. Remove the lamp by pulling it away from the socket.

Replace the X-ray Indicator Lamps
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9 Maintenance and Troubleshooting

4. Push lamp socket lever toward the analyzer and insert replacement lamp into socket.

5. Replace the indicator cover lens.
6. Connect the analyzer power cord to an AC power source.
7. Power ON the analyzer.
8. Place the keyswitch in the appropriate position.
9. Verify that the lamp is working.
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REPLACE THE MIXING PUMP TUBING

1. Place the analyzer on the edge of a table or flat surface.
2. Remove the pump chassis cover.
3. Drain the system. See Drain the System on page 9 - 22.
4. Power OFF the Pump Control.
5. Rotate the mixing pump lever to the left (the mixing pump is the pump on the right) to place

the mixing pump housing in the open position.

A. Mixing pump lever (open position)
B. Mixing pump tubing

6. Remove the mixing pump flexible tubing from the rigid tubing connectors on both sides of
the pump. Discard the used tubing.

7. Using the tube installation tool supplied in the accessories kit, attach one end of the new
flexible mixing pump tubing to the rigid tubing connector on the right.

8. Thread the tubing through the pump as shown below.

9. Attach the other end of the tubing to the rigid connector on the left.
10. Rotate the mixing pump lever to the right to place the mixing pump housing in the closed

position.
11. Replace the pump chassis cover.
12. Power ON the Pump Control.

Replace the Mixing Pump Tubing
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9 Maintenance and Troubleshooting

PERFORM A REFERENCE MATERIAL ANALYSIS

It is a good practice to perform a reference material analysis every week to ensure that the
analyzer is operating within specifications. Reference material kits, including instructions for
performing the reference material analysis, are available from Micromeritics.
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CAUSE OF BUBBLES

If bubble problems continue to exist, perform the following steps to determine their source.

1. Install a clean, cell assembly in the cell holder and ensure it is free of bubbles.
2. Go to Unit [n] > Baseline and perform the steps for collecting baseline data.

If the analyzer is successful in obtaining a baseline, the cell proceeds to a parked position,
indicating that bubbles are caused by:

n improper tubing routing,
n a failed valve,
n window misalignment, or
n a loose inlet / outlet port on the cell assembly.

If the analyzer is unable to obtain a baseline, an error message appears in the lower status
window. This indicates X-ray detection and / or generation problems may be present.
Contact your Micromeritics service representative for corrective action.

Cause of Bubbles
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9 Maintenance and Troubleshooting

POWER INSTRUMENT ON AND OFF

DO NOT connect or disconnect cables when the instrument is powered ON.

Power ON the equipment in the following order:

1. Computer, monitor, and printer.
2. Place the Pump Control switch (located on the front panel) in the AUTO position.
3. Analyzer.
4. Insert the X-ray key into the X-ray keyswitch then turn the switch to the X-RAY ON position.
5. Wait 30 minutes for the analyzer to warm up before performing an analysis.

It is recommended that the analyzer remain on unless it is going to be idle for a period
of more than 24 hours. Leaving the analyzer on helps prolong the life of its major com-
ponents.

Power OFF the equipment in the following order:

Always exit the analysis program before turning off the computer. Failure to do so
could result in loss of data.

1. Exit the analysis program. If an analysis is in progress when closing the application, the fol-
lowing message is displayed:

Instrument is busy. Continue program exit?

Select Yes and the analysis program closes. The analysis continues and data
continue to be collected. Queued reports under the printer will print. If a
power failure occurs and an uninterruptible power supply (UPS) is not
attached to the analyzer, the data collected after exiting the analysis program
are lost.

Select No to continue the analysis. Select Yes to close the application.
2. Computer, monitor, printer.
3. Analyzer.
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RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.

Recover from a Power Failure
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9 Maintenance and Troubleshooting

MASTERTECH TROUBLESHOOTING AND MAINTENANCE

Power failure

Cause A: Power cable not connected or switch not in ON position.

Action A: Make sure power cable is plugged into the power source and the power
ON/OFF switch is in the ON position.

Cause B: Input power fuse blown.

Action B: Replace the fuse. See Replace the Input Power Fuse on the facing page.

Stirrer will not work.

Cause: Stirrer is improperly connected.

Action: Check the stirrer’s electrical connection.

Turntable will not move.

Cause: Arm is in the LOAD position.

Action: Press the AUTO/LOAD switch on the front panel to lower the arm.

MasterTech pump will not run.

Cause: Pump switch on the front panel may be in the OFF position.

Action: Press the pump AUTO/ OFF switch on the front panel.

Ultrasonic probe will not work.

Cause: Probe improperly connected to the MasterTech.

Action: Check the MasterTech connector cable.

Ultrasonic agitation diminished.

Cause: The ultrasonic probe tip may need replacing.

Action: See Replace the MasterTech Ultrasonic Probe Tip on the facing page.

MasterTech will not initiate commands from the computer.

Cause: The cable may be connected improperly from the MasterTech to the computer.
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Action: Check the cable connections.

Pump leaks or is not operating efficiently.

Cause: Tubing is leaking or clogged.

Action: See Replace the Flexible Tubing on page 9 - 18.

REPLACE THE MASTERTECH ULTRASONIC PROBE TIP

Parts and accessories are located on the Micromeritics web page.

After extended periods of use, the tip of the ultrasonic probe on the MasterTech may become
pitted, causing diminished agitation.

1. Remove the damaged tip from the probe using the wrenches provided.
2. Attach the new probe tip to the probe body. Use the wrenches to tighten securely.

Never hold the probe by the tip. Doing so may cause damage to the probe.

REPLACE THE INPUT POWER FUSE

A. Power switch
B. Power connector
C. Fuse cover

n The power cord should be disconnected from the instrument before removing the
cover from the input power connector. Failure to disconnect the power cord could
result in electrical shock.

n The input power connector can be used with either a single-fuse arrangement or a
double-fuse arrangement. Use the appropriate fuse(s) for the input power source.
The fuses must be identical in type and rating to that specified. Use of other fuses
could result in electrical shock and/or damage to the instrument. Fuse
requirements are listed in the following table.

Replace the MasterTech Ultrasonic Probe Tip
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9 Maintenance and Troubleshooting

Fuses may be obtained fromMicromeritics or a vendor of your choice as long as they
meet the requirements specified in this section.

Power Source Required Fuses
100-120VAC Single fuse, 3AG (Slo-Blo) 250V, 2.0AL, 6.35 mm x 31.7 5 mm.

Single pole input.
220-240VAC Double fuse, Time-lag (Slo-Blo), 250V, 1.25AL, 5 mm x 20 mm.

Double pole input.

1. Ensure the instrument is powered OFF and the power cord is disconnected.
2. Open the cover to the right of the power entrance and remove the fuse block by inserting the

tip of a small pocket screwdriver (or pointed object) in the left side of the power module then
gently prying the cover open.

Do not to pry in the middle of the cover near the hinges. Doing so may break the
hinge.

A. Fuse cover closed
B. Fuse cover opened (swing to

the left)
C. Fuse block removed

3. Gently lift until the cover opens approximately 1/4 inch, then swing the hinged cover to the
left.

4. Remove the fuse block. If necessary, use needle-nose pliers to grasp the block.
5. Insert the appropriate fuse(s) for the input power source.

6. Position the fuse block so that the side containing the fuse(s) is facing the power module
and insert it into the connector. Do not close the cover.

7. Fuse the power line according to local safety practices.
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n If the single-fuse arrangement is used, the fuse block is positioned so that the side with the
single-fuse slot and the jumper bar is away from the cover.

n If the double-fuse arrangement is used, the fuse block is positioned so that the side with
the double-fuse slots is away from the cover (insert just opposite of single-fuse
arrangement).

8. Snap the fuse block and cover assembly back into the input power connector. If the fuse
block does not seat properly:

a. Remove the fuse block retaining screw.
b. Lift the fuse block from the cover.
c. Rotate the fuse block.
d. Mount the fuse block to the cover.
e. Replace the retaining screw.

Once the fuse block and cover assembly are in place, the position of the indicator pin shows the
input power selected.

Replace the Input Power Fuse
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A ADVANCED REPORTS - PYTHON MODULE

The mic Python module is automatically imported when running a user supplied script. The
module provides access to particle size data, and provides support for summary, tabular, and
graphical reports.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

A Advanced Reports - Python Module
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A Advanced Reports - Python Module

ADVANCED REPORT OPTIONS

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 30 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. On the Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.
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Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

Advanced Reports

Advanced Report Options
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A Advanced Reports - Python Module

SCRIPTS

Run a Script

1. Open a sample file with a Complete file status.
2. Select Advanced in the view selector drop-down list at the bottom of the window.
3. Select the Report Options tab.
4. Highlight Advanced in the Selected Reports list box, then click Edit.
5. On the Advanced Report Options window, click Add.
6. Locate and select one or more python scripts then click Select. The selected scripts

become a part of the drop-down list in the Available Scripts section of the Advanced Report
Options window.

7. In the Select Reports section, select up to five Advanced reports in the drop-down lists.
8. ClickOK.
9. Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.

Edit a Script

Selections Description
Add [button] Adds one or more scripts to the Available Scripts box. The added

scripts then become available as options in the Selected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Remove [button] Removes the script from the Available Scripts box but does not affect
original .py text file.

Replace [button] Replaces the contents of the selected script however, the script
name remains the same.
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PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

1 import mic

2 import numpy as np

3

4 mic.graph( 'My Graph', 'X', 'F(X)' )

5 myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ] )

6 mic.graph.add( 'X2', myx, myx*myx, marker='o' )

7 mic.graph.add( 'sin(X)', myx, np.sin(myx), marker='^' )

The results are:

Python Reports
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A Advanced Reports - Python Module

Summary Report

This script produces a summary report with two summaries:

1 import mic

2 import numpy as np

3

4 mic.summary( "My Summaries" )

5 mic.summary.add( "Summary A",

6 ["Label 1:", "Label 2:", "Label 3:"],

7 ["val1", "val2", "val3"] )

8 mic.summary.add( "Summary B",

9 ["Label 4:", "Label 5:", "Label 6:"],

10 ["val4", "val5", "val6"] )

The result is:
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Tabular Report

If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.

This script uses the Python package numpy and c-style formatting of the numerical
values.

11 import mic

12 import numpy as np

13

14 mic.table( "My Tables" )

15 mic.table.addtable( "My Set A" )

16 mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )

17 mic.table.addcolumn( "Y", ["0.5", "1.0", "1.5"] )

18 x1 = 0.2

19 x2 = 0.5

20 x3 = 3.14159/2

21 mic.table.addtable( "My Set B" )

22 mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),

23 '{:8.3f}'.format(x2),

24 '{:8.3f}'.format(x3)] )

25 mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),

26 '{:8.3f}'.format(np.sin(x2)),

27 '{:8.3f}'.format(np.sin(x3))] )

28 mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),

29 '{:8.3f}'.format(np.cos(x2)),

30 '{:8.3f}'.format(np.cos(x3))] )

Python Reports
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A Advanced Reports - Python Module

The result is:
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ACQUIRE BASIC INFORMATION

The following script generates a report that lists sample information, material properties, analysis
options, and collected sedimentation data. SeeGet Particle Sizing Sample on page A - 18 for
API information.

1 from math import log

2 import numpy as np

3 import mic

4

5 sample_data = mic.particle_sizing_sample()

6 coarser_data = mic.particle_sizing_coarser()

7 finer_data = mic.particle_sizing_finer()

8 reference_data = mic.particle_sizing_reference()

9 overlays_data = mic.particle_sizing_overlay(0)

10

11 sample_information = sample_data["SampleInfo"]

12 mat_props = sample_data["MaterialProperties"]

13 anl_opts = sample_data["AnalysisOptions"]

14 collected_data = sample_data["CollectedData"]

15

16 # Sample information

17 mic.summary(title="Summary Report")

18 params = sample_information["params"]

19 params_summary = []

20 sampleinfo_summary = [

21 ['Description:', sample_information["sample description"]],

22     ] + [["Parameter {} - {}:".format(i + 1, params[i]['name']),

23 "{}".format(params[i]['value'])]

24 for i in range(len(sample_information["params"]))]

25 mic.summary.add('Sample Information',

26 [desc for desc, value in sampleinfo_summary],

27 [value for desc, value in sampleinfo_summary])

Acquire Basic Information
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A Advanced Reports - Python Module

28

29 # Material properties

30 interp_tbl = mat_props["interpolation table"]

31 matprops_summary = [

32 ['Analysis type:',          mat_props["analysis type"]],

33 ['Starting size:',          "{} µm diameter".format(mat_props["starting
size"])],

34 ['Ending size:',            "{} µm diameter".format(mat_props["ending
size"])],

35 ['Sample ID:',              mat_props["sample ID"]],

36 ['Sample density:',         "{} g/cm³".format(mat_props["sample
density"])],

37 ['Liquid ID:',              mat_props["liquid ID"]],

38 ['Liquid fixed density:',   "{} g/cm³".format(mat_props["liquid fixed
density"])],

39 ['Liquid fixed viscosity:', "{} mPa*s".format(mat_props["liquid fixed
viscosity"])],

40 ['X-ray intensity:',        mat_props["xray intensity"]],

41     ] + [["Interpolation table row {}:".format(i + 1),

42 "Cell temperature: {} °C, Density: {} g/cm³, Viscosity: {} mPa*s"

43           .format(interp_tbl[i]["cell temperature"],

44                   interp_tbl[i]["density"],

45                   interp_tbl[i]["viscosity"])]

46 for i in range(len(interp_tbl))]

47 mic.summary.add('Material Properties',

48 [desc for desc, value in matprops_summary],

49 [value for desc, value in matprops_summary])

50

51 # Analysis options

52 anlopts_summary = [

53 ['MasterTech stir time:',   "{} sec".format(anl_opts['mt stir time'])],

54 ['MasterTech stir speed:',  anl_opts['mt stir speed']],

55 ['MasterTech probe time:',  "{} sec".format(anl_opts['mt probe time'])],

56 ['Stop at mass percent:',   anl_opts['stop at mass percent']],
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57 ['Ending percent:',         "{}%".format(anl_opts['ending percent'])],

58 ['Number of tests:',        anl_opts['number of tests']],

59 ['Leave pump on:', 'yes' if anl_opts['leave pump on'] else 'no'],

60 ['Wait for temperature stabilization:',

61 'yes' if anl_opts['wait for temp stabilization'] else 'no'],

62 ['Mixing stir speed:',      anl_opts['mix stir speed']],

63 ['Full scale pump speed:',  anl_opts['full scale pump speed']],

64 ['Bubble detection:',       anl_opts['bubble detection']],

65 ['Rinse after analysis:',   anl_opts['rinse after analysis']],

66 ['Auto rinse:',             anl_opts['is auto rinse']],

67 ['Rinse cycles:',           anl_opts['rinse cycles']],

68 ['Rinse pump speed:',       anl_opts['rinse pump speed']],

69 ]

70 mic.summary.add('Analysis Options',

71 [desc for desc, value in anlopts_summary],

72 [value for desc, value in anlopts_summary])

73

74 # Collected data

75 colldata_summary = [

76 ["Mean base/Full:", '{:.4f} kCnts/s'.format(collected_data["mean base/-
full"])],

77 ["Base/Full scale:", '{:.4f} kCnts/s'.format(collected_data["base/full
scale"])],

78 ]

79 mic.summary.add('Collected Data',

80 [desc for desc, value in colldata_summary],

81 [value for desc, value in colldata_summary])

82

83 # Cumulative mass graph

84 test = 'avg'

85 dist = 'mass'

86 mic.graph(title='Cumulative Mass Test Average',

87           xlabel='Particle size (µm diameter)', ylabel='Cumulative')

Acquire Basic Information
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A Advanced Reports - Python Module

88 xs = collected_data['low diameter'][test][dist]

89 ys = collected_data['cumulative'][test][dist]

90 mic.graph.add("Cumulative", xs, ys)

91

92 # Sedimentation data table

93 test = '1' # First test

94 sedtimes = collected_data['unsmoothed']['sedimentation times'][test]

95 sedheights = collected_data['unsmoothed']['sedimentation heights'][test]

96 sedperiods = collected_data['unsmoothed']['sedimentation periods'][test]

97 mic.table(title="Sedimentation Data for Test {}".format(test))

98 mic.table.addtable('Sedimentation Data')

99 mic.table.addcolumn('Sedimentation time (sec)', [sedtime/100.0 for sedtime
in sedtimes])

100 mic.table.addcolumn('Sedimentation height (cm)', ['{:.4f}'.format(height)
for height in sedheights])

101 mic.table.addcolumn('Sedimentation period (µs)', ['{:.4f}'.format(period)
for period in sedperiods])
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ACQUIRE REPORT RESULTS

The Advanced Reports provide a way to access Log Probability, Rosin Rammler, Baseline, and
Fullscale data.

1 import mic

2 import numpy as np

3

4 # Returns slope, intercept, r² information.

5 def get_linear_fit(xs, ys):

6     slope, intercept = np.polyfit(xs, ys, 1)

7     correlation_matrix = np.corrcoef(xs, ys)

8     correlation_xy = correlation_matrix[0,1]

9     r_squared = correlation_xy ** 2

10 return slope, intercept, r_squared

11

12 sample_data = mic.particle_sizing_sample()

13 collected_data = sample_data["CollectedData"]

14

15 # Log probability graph

16 test = 'avg'

17 dist = 'mass'

18 mic.graph(title='Log Probability for {} using {} Distribution'.format(test,
dist),

19           xlabel='Particle size (µm)', ylabel='Logprob')

20 logprob = collected_data['logprob'][test][dist]

21 slope, intercept, r_squared = get_linear_fit(logprob['X'], logprob['Y'])

22 mic.graph.add("Logprob: slope={:.4f}, intercept={:.4f}, r²={:.4f}"

23               .format(slope, intercept, r_squared),

24               logprob['X'], logprob['Y'])

25

26 # Rosin Rammler graph

27 test = '1' # First test

28 dist = 'mass'

Acquire Report Results

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 A - 13
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29 mic.graph(title='Rosin Rammler for Test {} using {} Distribution'.format
(test, dist),

30           xlabel='Particle size (µm)', ylabel='RR')

31 rosinrammler = collected_data['rosinrammler'][test][dist]

32 slope, intercept, r_squared = get_linear_fit(rosinrammler['X'], rosinrammler
['Y'])

33 mic.graph.add("RR: slope={:.4f}, intercept={:.4f}, r²={:.4f}"

34               .format(slope, intercept, r_squared),

35               rosinrammler['X'], rosinrammler['Y'])

36

37 # Baseline graphs

38 mic.graph(title='Raw Baseline', xlabel='Cell position (cm)', ylabel='Intens-
ity (µs)')

39 xs = collected_data['baseline']['heights']

40 ys = collected_data['baseline']['periods']

41 mic.graph.add("Baseline", xs, ys)

42 mic.graph(title='Reported Baseline', xlabel='Cell position (cm)',
ylabel='Intensity (1000/µs)')

43 reported_xs = [0.01 if x < 1.0e-6 else x for x in xs]

44 reported_ys = [1.0e3 / y if y > 1.0e-6 else 0.0 for y in ys]

45 mic.graph.add("Baseline", reported_xs, reported_ys)

46

47 # Fullscale graphs

48 mic.graph(title="Raw Fullscale for Test {}".format(test),

49           xlabel='Cell position (cm)', ylabel='Intensity (µs)')

50 xs = collected_data['fullscale'][test]['heights']

51 ys = collected_data['fullscale'][test]['periods']

52 mic.graph.add('Fullscale raw', xs, ys)

53 mic.graph(title="Reported Fullscale for Test {}".format(test),

54           xlabel='Cell position (cm)', ylabel='Intensity (1000/µs)')

55 reported_xs = [0.01 if x < 1.0e-6 else x for x in xs]

56 reported_ys = [1.0e3 / y if y > 1.0e-6 else 0.0 for y in ys]

57 mic.graph.add("Fullscale", reported_xs, reported_ys)

58
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ACQUIRE OVERLAY SAMPLE DATA

There are four functions that can be used to get overlay information. The Report Optionsmust
have:

n Reference (corresponds to particle_sizing_reference),
n Specification (corresponds to def particle_sizing_coarser() and def particle_sizing_finer()),
n Overlays (corresponds to def particle_sizing_overlays(number)) selection

1 Acquire Overlay Sample Data

2 def particle_sizing_coarser():

3 '''Get particle_sizing sample information, material properties, analysis
options,

4        and collected data of the coarser reference file.

5

6     Usage:

7

8       coarser = particle_sizing_coarser()

9

10     The returned dict has the same layout as the structure returned by

11     particle_sizing_sample()

12     '''

13

14 def particle_sizing_finer():

15 '''Get particle_sizing sample information, material properties, analysis
options,

16        and collected data of the finer reference file.

17

18     Usage:

19

20       finer = particle_sizing_finer()

21

22     The returned dict has the same layout as the structure returned by

23     particle_sizing_sample()

Acquire Overlay Sample Data
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24     '''

25

26 def particle_sizing_reference():

27 '''Get particle_sizing sample information, material properties, analysis
options,

28        and collected data of the reference reference file.

29

30     Usage:

31

32       reference = particle_sizing_reference()

33

34     The returned dict has the same layout as the structure returned by

35     particle_sizing_sample()

36     '''

37

38 def particle_sizing_overlay(sample_number):

39 '''Get particle sizing sample information, material properties, analysis
options,

40        and collected data of the sample_number overlay reference files.

41

42     Usage:

43

44       first_overlay = particle_sizing_overlay(0)

45

46     The returned dict has the same layout as the structure returned by

47     particle_sizing_sample()

48     '''

49

50 This is an example code block that makes use of it:

51 import mic

52

53 sample_data = mic.particle_sizing_sample()

54 collected_data = sample_data["CollectedData"]
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55 finer_data = mic.particle_sizing_finer()

56 reference_data = mic.particle_sizing_reference()

57 coarser_data = mic.particle_sizing_coarser()

58 first_overlay = mic.particle_sizing_overlay(0)

59

60

61 # Cumulative mass graph

62 test = 'avg'

63 dist = 'mass'

64 mic.graph(title='Cumulative Mass Test Average',

65           xlabel='Particle size (µm diameter)', ylabel='Cumulative')

66 xs = sample_data['CollectedData']['low diameter'][test][dist]

67 ys = sample_data['CollectedData']['cumulative'][test][dist]

68 mic.graph.add("Sample", xs, ys)

69 xs = finer_data['CollectedData']['low diameter'][test][dist]

70 ys = finer_data['CollectedData']['cumulative'][test][dist]

71 mic.graph.add("finer", xs, ys)

72 xs = coarser_data['CollectedData']['low diameter'][test][dist]

73 ys = coarser_data['CollectedData']['cumulative'][test][dist]

74 mic.graph.add("finer", xs, ys)

75 xs = reference_data['CollectedData']['low diameter'][test][dist]

76 ys = reference_data['CollectedData']['cumulative'][test][dist]

77 mic.graph.add("finer", xs, ys)

78

79

80
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GET PARTICLE SIZING SAMPLE

1 def particle_sizing_sample():

2 '''Get particle_sizing sample information, material properties, analysis
options,

3        and collected data.

4

5     Usage:

6

7       sample = particle_sizing_sample()

8

9     The returned dict has the following layout.

10

11     sample = {

12           'SampleInfo' : {

13               'sample description': str,

14               'params' :  list( {'name': str, 'value': float } )

15               },

16           'MaterialProperties' : {

17               'analysis type': str,

18               'starting size': float,

19               'ending size': float,

20               'sample ID': str,

21               'sample density': float,

22               'liquid ID': str,

23               'liquid fixed density': float,

24               'liquid fixed viscosity': float,

25               'xray intensity': str,

26               'interpolation table': {

27                   'cell temperature': double,

28                   'density': double,

29                   'viscosity': double,
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30                   },

31               },

32           'AnalysisOptions' : {

33               'mt stir time': float,

34               'mt stir speed': float,

35               'mt probe time': double,

36               'stop at mass percent': bool,

37               'ending percent': double,

38               'number of tests': int,

39               'leave pump on': bool,

40               'wait for temp stabilization': bool,

41               'mix stir speed': double,

42               'full scale pump speed': double,

43               'bubble detection': str,

44               'rinse after analysis': bool,

45               'is auto rinse': bool,

46               'rinse cycles': double,

47               'rinse pump speed': double,

48           },

49           'CollectedData': {

50               'analysis times': dict( {'0': str,

51                                        '2': str,

52                                        ...,

53                                        '7': str } ),

54               'unsmoothed': dict( { 'sedimentation heights': dict( { '0':
list(float),

55                                                                      '1':
list(float),

56                                                                      ...

57                                                                      '7':
list(float) } ),

58                                     'sedimentation times' : dict( { '0':
list(float),

59                                                                     '1':
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list(float),

60                                                                     ...

61                                                                     '7':
list(float) } ),

62                                     'sedimentation periods' : dict( { '0':
list(float),

63                                                                       '1':
list(float),

64                                                                       ...

65                                                                       '7':
list(float) } ),

66                                     'masses' : dict( { '0': list(float),

67                                                        '1': list(float),

68                                                        ...

69                                                        '7': list(float) } ),

70                                     'sizes' : dict( { '0': list(float),

71                                                       '1': list(float),

72                                                       ...

73                                                       '7': list(float) } ),

74                                    } )

75               'smoothed': dict( { 'masses' : dict( { '0': list(float),

76                                                      '1': list(float),

77                                                      ...

78                                                      '7': list(float) } ),

79                                   'sizes' : dict( { '0': list(float),

80                                                     '1': list(float),

81                                                     ...

82                                                     '7': list(float) } ) }
),

83               'mean base/full' : float,

84               'base/full scale' : float,

85               'low diameter' : dict( { '0' : dict( {

86                                                       'mass': list(float)

87                                                       'area': list(float)
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88                                                       'volume': list(float)

89                                                       'number': list(float)

90                                                    } ),

91                                        '1' : dict( { ... } ),

92                                        ...

93                                        '7' : dict( {... } ),

94                                        'avg' : dict( {... } ) } )

95               'high diameter': dict( { '0' : dict( {

96                                                       'mass': list(float)

97                                                       'area': list(float)

98                                                       'volume': list(float)

99                                                       'number': list(float)

100                                                    } ),

101                                        '1' : dict( { ... } ),

102                                        ...

103                                        '7' : dict( {... } ),

104                                        'avg' : dict( {... } ) } ),

105               'average diameter': dict( { '0' : dict( {

106                                                          'mass': list(float)

107                                                          'area': list(float)

108                                                          'volume': list
(float)

109                                                          'number': list
(float)

110                                                       } ),

111                                           '1' : dict( { ... } ),

112                                           ...

113                                           '7' : dict( {... } ),

114                                           'avg' : dict( {... } ) } ),

115               'cumulative': dict( { '0' : dict( {

116                                                    'mass': list(float)

117                                                    'area': list(float)

118                                                    'volume': list(float)
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119                                                    'number': list(float)

120                                                 } ),

121                                     '1' : dict( { ... } ),

122                                     ...

123                                     '7' : dict( {... } ),

124                                     'avg' : dict( {... } ) } ),

125               'frequency': dict( { '0' : dict( {

126                                                   'mass': list(float)

127                                                   'area': list(float)

128                                                   'volume': list(float)

129                                                   'number': list(float)

130                                                } ),

131                                    '1' : dict( { ... } ),

132                                    ...

133                                    '7' : dict( {... } ),

134                                    'avg' : dict( {... } ) } ),

135               'rosin rammler': dict( { '0' : dict( {

136                                                       'mass': list(float)

137                                                       'area': list(float)

138                                                       'volume': list(float)

139                                                       'number': list(float)

140                                                    } ),

141                                        '1' : dict( { ... } ),

142                                        ...

143                                        '7' : dict( {... } ) } ),

144               'specific area': dict( { '0' : dict( {

145                                                       'mass': list(float)

146                                                       'area': list(float)

147                                                       'volume': list(float)

148                                                       'number': list(float)

149                                                    } ),

150                                        '1' : dict( { ... } ),
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151                                        ...

152                                        '7' : dict( {... } ),

153                                        'avg' : dict( {... } ) } ),

154               'area in interval': dict( { '0' : dict( {

155                                                          'mass': list(float)

156                                                          'area': list(float)

157                                                          'volume': list
(float)

158                                                          'number': list
(float)

159                                                       } ),

160                                           '1' : dict( { ... } ),

161                                           ...

162                                           '7' : dict( {... } ),

163                                           'avg' : dict( {... } ) } ),

164               'specific number': dict( { '0' : dict( {

165                                                         'mass': list(float)

166                                                         'area': list(float)

167                                                         'volume': list
(float)

168                                                         'number': list
(float)

169                                                      } ),

170                                          '1' : dict( { ... } ),

171                                          ...

172                                          '7' : dict( {... } ),

173                                          'avg' : dict( {... } ) } ),

174               'number in interval': dict( { '0' : dict( {

175                                                            'mass': list
(float)

176                                                            'area': list
(float)

177                                                            'volume': list
(float)

178                                                            'number': list
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(float)

179                                                         } ),

180                                             '1' : dict( { ... } ),

181                                             ...

182                                             '7' : dict( {... } ),

183                                             'avg' : dict( {... } ) } ),

184               'log probability': dict( { '0' : dict( {

185                                                         'mass': list(float)

186                                                         'area': list(float)

187                                                         'volume': list
(float)

188                                                         'number': list
(float)

189                                                      } ),

190                                          '1' : dict( { ... } ),

191                                          ...

192                                          '7' : dict( {... } ),

193                                          'avg' : dict( {... } ) } ),

194               'phi size': dict( { '0' : dict( {

195                                                  'mass': list(float)

196                                                  'area': list(float)

197                                                  'volume': list(float)

198                                                  'number': list(float)

199                                               } ),

200                                   '1' : dict( { ... } ),

201                                   ...

202                                   '7' : dict( {... } ),

203                                   'avg' : dict( {... } ) } ),

204               'settling velocity': dict( { '0' : dict( {

205                                                           'mass': list
(float)

206                                                           'area': list
(float)

207                                                           'volume': list
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(float)

208                                                           'number': list
(float)

209                                                        } ),

210                                            '1' : dict( { ... } ),

211                                            ...

212                                            '7' : dict( {... } ),

213                                            'avg' : dict( {... } ) } ),

214               'phi size low': dict( { '0' : dict( {

215                                                      'mass': list(float)

216                                                      'area': list(float)

217                                                      'volume': list(float)

218                                                      'number': list(float)

219                                                   } ),

220                                       '1' : dict( { ... } ),

221                                       ...

222                                       '7' : dict( {... } ),

223                                       'avg' : dict( {... } ) } ),

224               'settling velocity low': dict( { '0' : dict( {

225                                                               'mass': list
(float)

226                                                               'area': list
(float)

227                                                               'volume': list
(float)

228                                                               'number': list
(float)

229                                                            } ),

230                                                '1' : dict( { ... } ),

231                                                ...

232                                                '7' : dict( {... } ),

233                                                'avg' : dict( {... } ) } ),

234

235               'baseline' : dict( { 'heights' : list(float), 'periods' : list
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(float) } ),

236               'fullscale' : dict( { '0' : dict( { 'heights' : list(float),
'periods' : list(float) } ),

237                                     '1' : dict( { ... } ),

238                                     ...

239                                     '7' : dict( { ... } ),

240                                     'avg' : dict( {... } ) } ),

241               'logprob'     : dict( {'0': {'mass': { 'X' : list(float),

242                                                      'Y' : list(float) }

243                                            'area': { ... },

244                                            'number': { ... },

245                                            'volume': { ... },

246                                           },

247                                      '1': {...},

248                                      ...

249                                      '7': {...},

250                                      'avg': {...},

251                                     } )

252               'rosinrammler': dict( {'0': {'mass': { 'X' : list(float),

253                                                      'Y' : list(float), }

254                                            'area': { ... },

255                                            'number': { ... },

256                                            'volume': { ... },

257                                           },

258                                      '1': {...},

259                                      ...

260                                      '7': {...},

261                                      'avg': {...},

262                                     } )

263           }

264     }

265     '''

266
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267 def particle_sizing_coarser():

268 '''Get particle_sizing sample information, material properties, analysis
options,

269        and collected data of the coarser reference file.

270

271     Usage:

272

273       coarser = particle_sizing_coarser()

274

275     The returned dict has the same layout as the structure returned by

276     particle_sizing_sample()

277     '''

278

279 def particle_sizing_finer():

280 '''Get particle_sizing sample information, material properties, analysis
options,

281        and collected data of the finer reference file.

282

283     Usage:

284

285       finer = particle_sizing_finer()

286

287     The returned dict has the same layout as the structure returned by

288     particle_sizing_sample()

289     '''

290

291 def particle_sizing_reference():

292 '''Get particle_sizing sample information, material properties, analysis
options,

293        and collected data of the reference reference file.

294

295     Usage:

296
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297       reference = particle_sizing_reference()

298

299     The returned dict has the same layout as the structure returned by

300     particle_sizing_sample()

301     '''

302

303 def particle_sizing_overlay(sample_number):

304 '''Get particle sizing sample information, material properties, analysis
options,

305        and collected data of the sample_number overlay reference files.

306

307     Usage:

308

309       first_overlay = particle_sizing_overlay(0)

310

311     The returned dict has the same layout as the structure returned by

312     particle_sizing_sample()

313     '''

314
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ENABLE THE USE OF OVERLAY DATA

1. On the Report Options tab, clickOverlays.
2. On the Plot Overlay Sample Selection window, to move a file from the Available Files list

box to the Selected Files list box, either double-click a file name in the Available Files list
box or click one or more files in the Available Files list box then click Add.

3. ClickOK.
4. On the Report Options tab, highlight Advanced in the Selected Reports list box.
5. On the Advanced Report Options window, click Add in the Available Scripts group box and

select a Python script.
6. In the Select Reports group box, select the drop-down arrow to select a report to be used in

the overlay.
7. ClickOK.
8. Run the script using the instructions found in Scripts on page A - 4.
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MICMODULE PYTHON CALLS

Tables

Available Mic Python calls for tables:

n Create a new tabular report
n Add a column
n Add a table

Add a Table

This script adds a table to the last created tabular report:

1 mic.table.addtable( name )

2

3 Keyword arguments:

4

5   name --- the table name

Add a Column

This script adds a column to the last created table:

1 mic.table.addcolumn(header, values, align='r'):

2

3 Keyword arguments:

4

5   header --- column header; must be a string (or convertible)

6   values --- column values; must be a list of strings (or convertible)

7   align  --- column alignment; 'r', 'l', 'c' for right, left, and center jus-
tified
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Create a New Tabular Report

1 mic.table( title='User Table' )

2

3 Keyword arguments:

4

5   title --- the tabular report title (default = 'User Table')
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Summary Reports

Add a Summary Section

This script adds a summary section to the last created summary report:

1 mic.summary.add(name, labels, values):

2

3 Keyword arguments:

4

5   name   --- summary section name

6   labels --- column of labels; must be a list of strings

7 (or convertible) and the same length as values

8   values --- column of values; must be a list of strings

9 (or convertible) and the same length as labels

Create a New Summary Report

1 mic.summary( title='User Summary' )

2

3 Keyword arguments:

4

5   title --- the summary title
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Graphic Reports

Add a Curve

This script adds a curve to the last created graphical report:

1 mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',

2               marker='a', graphtype='both', interpolation='akima'):

3

4 Keyword arguments:

5

6   name      --- the curve name

7   x         --- list of x values; must be a list of floats

8 (or convertible) and the same length as y

9   y         --- list of y values; must be a list of floats

10 (or convertible) and the same length as x

11   yyaxis    --- place this curve on the yy-axis if True

12                 otherwise place on the y-axis (default = False)

13   color     --- RGB color as an HTML hex string (e.g., '#4169e1')

14 or a three-element list or tuple (e.g., [65,105,225]);

15 if None, color is automatically selected (default = None)

16   linestyle --- line style; (default = '-')

17 '-'        : solid

18 '--'       : dash

19 '.'        : dot

20 '-.'       : dash dot

21 '-..'      : dash dot dot

22   marker    --- marker shape; (default = 'a')

23 '+'        : plus

24 'o' or '0' : circle

25 'x'        : cross

26 '^'        : up triangle

27 'v'        : down triangle

28 's'        : square
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29 'd'        : diamond

30 '8'        : hourglass

31 '~'        : horizontal hourglass

32 '' or None : no marker

33 'a'        : automatically selected

34   graphtype --- graph type; (default = 'both')

35 'curve' or 'c' : curve

36 'points' or 'p' : points

37 'both' or 'b' : curve-and-points

38 'hist' or 'h' : histogram

39   interpolation -- linear or akima spline interpolation (default='akima')

40 'akima' use akima spline

41 'linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

1 mic.graph.addyy(name, xx, yy):

2

3 Add a curve to the last created graphical report using the second

4 y-axis. The arguments to this call are the same as to mic.graph.add.
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Create a New Graphical Report

1 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis',

2           yylabel='YY axis',

3           xlinear=True, ylinear=True, yylinear=True,

4           xinvert=False, yinvert=False, yyinvert=False,

5           xrange=None, yrange=None, yyrange=None, xbars_id=''):

6

7 Keyword arguments:

8

9   title    --- the graphical report title (default = 'User Graph')

10   xlabel   --- x-axis label (default = 'X axis')

11   ylabel   --- y-axis label (default = 'Y axis')

12   yylabel  --- yy-axis label (default = 'YY axis')

13   xlinear  --- x-axis linear scale; if false, use log scale

14 (default = True)

15   ylinear  --- y-axis linear scale; if false, use log scale

16 (default = True)

17   yylinear --- yy-axis linear scale; if false, use log scale

18 (default = True)

19   xinvert  --- Invert x-axis if true (default = False)

20   yinvert  --- Invert y-axis if true (default = False)

21   yyinvert --- Invert yy-axis if true (default = False)

22   xrange   --- None, or two values giving the min and max

23                range of the axis.

24   yrange   --- None, or two values giving the min and max

25                range of the axis.

26   yyrange  --- None, or two values giving the min and max

27                range of the axis.

28   xbars_id --- None, or the id of an xbar control created

29                via the mic.control() object
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Get Sample Information Item

1 mic.sample_information( item, sample_number = 0 ):

2

3 Keyword arguments:

4

5   item          --- string identifying the item to be returned.

6                     For example; 'sample mass', or 'sample description'

7                     The default is an empty string for which the return

8                     value is a list of all available keywords

9

10   sample_number --- Sample to retrieve

11 0           : current sample file (default)

12 1 through 8 : corresponding overlay sample file

13

14 Usage:

15

16   all_keywords = sample_information()

17   mass         = sample_information('sample mass')

18   mass         = sample_information('sample mass',0)
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B CHEMICAL AIDS FOR PARTICLE DISPERSION
Name Type Active Ingredient
Aerosol 22 Anionic Tetrasodium N-(1,2-dicarboxyet hyl)-Noct-

adecysulfosuccinanate, 35%
Aerosol OT Anionic Dioctyl ester of sodium sulfosuccinic acid, 70%

Atlas G-3300 Anionic Amine salt of alkylaryl sulfonate

Calcium Chloride Cationic CaCl2
Calgon Anionic Sodium hexametaphosphate, unadjusted

Calgon T Anionic Part of sodium replaced by other cations, predominantly zinc

Cobaltous Chloride Cationic CoCl2
Cobalt Citrate Anionic Co3(C6H5O7)2
Daxad 23 Anionic Sodium salt of polymerized carboxylic acid, 25%

Daxad 30 Anionic Sodium salt of polymerized carboxylic acid, 25%

FC-134 Cationic Fluorochemical surfactant

FC-161 Anionic Fluorochemical surfactant

FC-170 Nonionic Fluorochemical surfactant

Igepal CO-530 Nonionic Nonylphenoxypoly (ethyleneoxy) ethanol, 100%

Oleic Acid Anionic CH3(CH2)7CH=CH(CH2)7COOH

Renex 648 Nonionic Ethoxylated nonylphenol, 100%

Sodium Silicate Anionic Na2SiO3

Triton X-100 Nonionic Octyl phenoxy polyethoxy ethanol, 100%

Tamol SN Anionic Sodium salt of condensed naphthalene sulfonic acid, 100%

TSPOP Anionic Tetrasodiumpyrophosphate, Na4P2O7

Twitchell Base 8240 Anionic Sodium salt of low molecular weight, sulfonated oil, parafin
oil, water, and diethylene glycol

Tween 20 Nonionic Polyoxyethylene Sorbitan monolaureate (polysorbate 20),
100%

Zonyl S-13 Anionic Fluoroalkyl phosphate

Zonyl A Nonionic Ethylene oxide-ester condensate

Data extracted fromMcCutcheon’s Detergents and Emulsifiers, McCutcheon Division, MC
Publishing Co., Glen Rock, NJ, 1980.

B Chemical Aids for Particle Dispersion
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C DATA REDUCTION

DATA ACQUISITION
The basic data acquired are in the form of cumulative mass percent finer vs. diameter. An
explanation of the method for acquiring the data are provided below.

DIAMETER

Diameter for a given set of sedimentation conditions is given by Stokes equation as follows:

where

D = diameter (cm, multiply by 10000 for micrometers)
η = liquid viscosity (poise, multiply by 0.01 for cp)
h = sedimentation height (cm)
ρ = sample density (g/cm3)
ρo = liquid density (g/cm3)
g = acceleration due to gravity (981 cm/s/s)
t = sedimentation time (sec)

All data are acquired at one of 220 predetermined sedimentation heights, ranging from 2.54 cm to
0.0079375 cm.

Sample density is user-entered. Liquid viscosity and density are user-entered, or they are
calculated using the sedimentation cell temperature and interpolating from the user-selected
Liquid Properties Set (see Liquid Properties Interpolation).

Target diameters for data collection are determined as follows:

Up to 250 target diameters are selected, evenly spaced on a log diameter basis, between the user
selected starting diameter and ending diameter. Note that this gives the operator some choice in
the resolution of the data relative to the log diameter axis: selecting a narrower range of analysis
provides more data points in a given range of diameters. Maximum resolution is obtained by
selecting starting and ending diameters spanning only one decade (factor of 10), providing 250
data points per decade resolution.

Target sedimentation heights and times are selected based on run type (high speed, standard, or
high resolution) and Stokes’ equation.

C Data Reduction
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C Data Reduction

During analysis, mass % data will be taken at these target heights, and as close to these target
times as possible, allowing for cell movement, data acquisition delay time, and sequential
collection of data points. The actual time of data collection will be recorded for each point, so that
actual diameter may be calculated later.

Height, time, density, and viscosity data are stored separately, so that corrections to density and
viscosity can be made after the analysis and diameters are recalculated.

LIQUID PROPERTIES INTERPOLATION

The density and viscosity of the sedimentation liquid at the time of analysis are interpolated as
follows, using a liquid properties table of three points of density and viscosity versus temperature,
and the cell temperature reading at the start of analysis.

DENSITY

t1, t2, t3 = temperatures from liquid properties table (degrees C)
d1, d2, d3 = densities at t1, t2, t3 respectively (g/cm3)
A = first order coefficient
β = second order coefficient
tc = cell temperature reading at start of analysis (degrees C)
ρo = liquid density at analysis temperature (g/cc)
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VISCOSITY

t1, t2, t3 = 1/(t + 273.15) for t = each of the 3 temperatures in the liquid properties
table (t in degrees C)

ʋ1, ʋ2, ʋ3 = ln(ʋ) for ʋ = each of the 3 viscosities (cp)
A, B, C = 0th, 1st, and 2nd order coefficients, respectively
tk = cell temperature at start of analysis (K, i.e., 273.15 + degrees C)
η = viscosity at analysis temperature (cp)

MASS PERCENT

The mass percent of sample present at a given sedimentation height after a given time is
determined by relating the x-ray transmission intensity at that point to the intensity with no sample
present (baseline), and the intensity with all of the sample present (full scale):

Im = intensity at data point (mass % being determined)
Ib = intensity at baseline (mass % = 0)
If = intensity at full scale (mass % = 100)

The Ib and If values are average values to minimize random variations in the X-ray intensity. The
average of these values is used to compute the mass percent.

One set of baseline data may be used for scaling multiple analyses until another set of baseline
data are collected.

After the sample is loaded while the cell pump is still on and the sample fully suspended and
evenly distributed throughout the cell, bubble elimination data are collected at between 110 and
220 predetermined analysis heights, based on the type of bubble elimination selected. In addition,
a single average full-scale value is computed at the starting analysis height.

Mass percent data appearing on the ‘Analysis Results’ screen has been smoothed with an 11-
point evenly weighted running average.
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C Data Reduction

When data are saved permanently after all analyses on a sample are completed, the mass
percent values are smoothed before storage in the sample file as follows:

The mass percent values are smoothed with an 11-point running average, just as for the ‘Analysis
Results’ screen. From these data, a set of mass percent values are interpolated at 250 evenly
spaced intervals on a log diameter basis, using linear interpolation between the two adjacent
collected points to get each evenly spaced point. This is done because the next smoothing step
requires evenly spaced data points, and the collected data can vary from even log diameter
spacing due to limitations on time of collection, as noted above.

The evenly spaced mass percent values are smoothed using a digital filter which removes high-
frequency variations from the data. The final, stored mass percent values are obtained by
interpolating to a standard size table with 40 logarithmicly, evenly-spaced sizes per decade.
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REDUCTION OF COLLECTED DATA

MASS DATA

In order to obtain cumulative mass percent data, the smoothed mass percent data scaled to the
specified full scale value:

For each of the total number of points collected:

Cumulative mass percent coarser data are simply the difference of scaled mass percent
finer data from 100:

For each of the total number of points collected:

These cumulative mass data (finer and coarser) are represented directly in tabular form and as y-
axis data in the CUMULATIVE MASS FINER VS. DIAMETER and CUMULATIVE MASS
COARSER VS. DIAMETER plots (cumulative mass distribution curve). Also, cumulative mass
data are used to derive mass frequency and log probability data.

MASS FREQUENCY DATA

The mass frequency of a particle size interval is the difference between the cumulative mass
percent interpolated at the end points of the interval. The interpolation is performed using a spline
fit to the cumulative mass data.

CUMULATIVE DATA

Any cumulative quantity can be expressed as Coarser or Finer (Retained or Passed on the
Tabular Report by Sieve Size).

For data defined by the standard class sizes (Summary, Tabular Defined by Size Class, and
Graphs):

CumFracCoarseri = ∑FreqFrack for all classes k such that AvgDiamk > AvgDiami

CumFracFineri = ∑FreqFrack for all classes k such that AvgDiamk > AvgDiami

CumFracRetaini = ∑FreqFrack for all classes k such that AvgDiamk > AvgDiami

CumFracPassi = ∑FreqFrack for all classes k such that AvgDiamk < AveDiami

      or equivalently,
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C Data Reduction

CumFracFineri = 1.0 - CumFracCoarseri-1

CumFracRetaini = CumFracCoarseri-1

CumFracPassi = 1.0 - CumFracCoarseri-1

For Tabular Defined by SizeTable or by Sieve Sizes:

CumFrac (Coarser or Finer, Retained or Passed) is calculated for the standard size
classes as defined above. CumFrac is then interpolated from CumFrac vs. Particle
Size at each particle size in the Size table or aperture size in the Sieve table.
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PEAK REPORT DATA

Peak report data are calculated as:

Starting at the small particle size end of the frequency distribution:

1. Scan DiffFreqFraci for a local maximum, i.e.,

DiffFreqFrack > DiffFreqFrack+1, and

DiffFreqFrack > DiffFreqFrack-1
AvgDiamk is the mode of the candidate peak.

2. Scan DiffFreqFraci from class k toward smaller particle sizes to find a local minimum, i.e.,

DiffFreqFracm = 0, or

DiffFreqFracm < DiffFreqFracm+1 and DiffFreqFracm < DiffFreqFracm-1
LowDiamm is the low diameter of the candidate peak.

3. Scan DiffFreqFraci from class k toward larger particle sizes to find a local minimum, i.e.,

DiffFreqFracn = 0, or

DiffFreqFracn < DiffFreqFracn+1 and DiffFreqFracn < DiffFreqFracn-1
HighDiamn is the high diameter of the candidate peak.

4. Sum values of FreqFraci from i=m to i=n.

If the sum is greater than or equal to the Minimum Fraction to Report, the candidate peak is
qualified and the sum is the Fraction of Distribution. Other peak quantities are calculated
using the same formulas as for the entire distribution, except the only range from class m to
class n is used.

Otherwise, the candidate peak is disqualified.

In either case, peak identification repeats from step 1, starting with class n. When the end of the
distribution is reached by scanning in either step 1 or step 3, peak identification is complete.

In step 1 if the end of the distribution is reached on an increasing frequency slope, i.e.,
DiffFreqFrack > DiffFreqFrack-1, then class k is treated as the mode of a candidate peak and as
the high size end of the candidate peak.

If the beginning or end of the distribution is reached while scanning for a local minimum in step 2
or 3, the beginning or ending class is treated as the local minimum.
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C Data Reduction

For calculating Standard Deviation for N tests, peaks from the various tests are simply matched by
their order, i.e., peak 1 from test 1 is matched with peak 1 from test 2, etc. If all tests do not have
the same number of peaks, Standard Deviation for N tests is reported as N/A (not available). If the
peak numbers are not the same and the user chose average of n tests, a single row is filled in with
all N/A (including the peak number).
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NUMBER FREQUENCY DATA

The number frequency is computed from the mass frequency distribution as defined by the
standard size classes.

For each class:

where

NumFreqN = NumberfFrequency for class N
MassFreqN = Mass frequency for class N
AvgDiam = Average diameter for class N

The cumulative number percent for a class is computed as the summation of the non-negative
frequencies for all smaller classes.

SURFACE AREA FREQUENCY DATA

The surface area frequency is computed from the mass frequency distribution as defined by the
standard size classes.

For each class:

where

AreaFreqN = NumberfFrequency for class N
MassFreqN = Mass frequency for class N
AvgDiam = Average diameter for class N

The cumulative number percent for a class is computed as the summation of the non-negative
frequencies for all smaller classes.
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C Data Reduction

SIZE STATISTICS

STANDARD DEVIATION OF QUANTITY FOR N TESTS

For quantity, substitute the variable name for which the standard deviation is being determined.
The subscript k refers to the test number.

If NumTests < = 1, StdDevTestQuantity = 0.

Otherwise,

MODE

In order to do a mode calculation, the definition of the standard classes is extended over the range
of input for all the data; frequencies are calculated for these classes. It is this frequency data that
is used in determining the peak quantities so that all the classes are of the same width.

ModeDiam = AvgDiami such that DiffFreqFraci is the maximum DiffFreqFrac

MEDIAN

MedianDiam = Diameter interpolated from HighDiam vs. CumFracCoarser at CumFracCoarser =
0.5.

If the calculation is being performed on a peak, the interpolation point is at
CumFracCoarser = (Cum-FracCoarserm + CumFracCoarsern)/2.
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ARITHMETIC CALCULATIONS

MEAN

STANDARD DEVIATION (OF THE DISTRIBUTION)

COEFFICIENT OF VARIATION

SKEWNESS

KURTOSIS

+Xẟ

where x is a user-selected number.

-Xẟ

where x is a user-selected number.
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C Data Reduction

GEOMETRIC CALCULATIONS

MEAN

GeoMeanDiam = 10

STANDARD DEVIATION (OF THE DISTRIBUTION)

STANDARD DEVIATION OF LOG

SKEWNESS OF LOG

KURTOSIS OF LOG

+Xẟ

-Xẟ
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SPECIFICATION / REFERENCE QUANTITIES

OUT OF SPEC

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample
distribution.

CoarseSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from Coarse
Specification distribution interpolated if the bins are of different size. This is always the average of
all tests in the named sample file.

FineSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from
FineSpecification distribution interpolated if the bins are of different size. This is always the
average of all the tests in the named sample file.

If {SampCumFracCoarseri-1 > CoarseSpecCumFracCoarseri-1}

OutSpecFracCoarseri = SampCumFracCoarseri-1 - CoarseSpecCumFrac
Coarseri-1

If {SampCumFracCoarseri-1 < FineSpecCumFracCoarseri-1}

OutspecFracCoarseri = SampCumFracCoarser - FineSpecCumFrac

Coarseri-1

or,

OutSpecFracFineri = -OutSpecFracCoarseri-1

OutSpecFracRetaini = OutSpecFracCoarseri-1

OutSpecFracPassi = OutSpecFracCoarseri-1
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C Data Reduction

DIFFERENCE FROM REFERENCE

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample
distribution.

RefSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from Reference
Specification distribution interpolated if the bins are of different size. This is always the average of
all the tests in the named sample file.

DiffRefCoarseri = SampCumFraci - RefCumFraci

or,

DiffRefFineri = DiffRefCoarseri-1

DiffRefRetaini = DiffRefCoarseri-1

DiffRefPassi = DiffRefCoarseri-1

MAXIMUM OUT OF SPEC

MaxOutSpecFrac = maximum (abs value (OutSpecFraci))

PASS / FAIL BY SPECIFICATION

If MaxOutSpecFrac = 0, PassFail = Passed by Specification

Otherwise, PassFail = FAILED by Specification
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SPC REPORT VARIABLES

REGRESSION CHART VARIABLES

The line of best fit for the Regression Chart is calculated by the usual least squares method. 1 ) If
there is only a single point or all N points have the same x-value, there can be no line of best fit in
the standard form.

The coefficient of correlation for this line is also calculated in the usual way. 2 )

CONTROL CHART VARIABLES

1 ) BASIC Scientific Subroutines Vol II, by F.R. Ruckdeschel, Copyright 1981 BYTE
Publications/McGraw Hill, p. 16.
2 ) Mathematical Handbook for Scientists and Engineers, G.A. Korn and T.M. Korn, McGraw Hill,
Sec. 18.4. (1968)
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REYNOLDS NUMBER
The Reynolds Number is calculated as follows:

where

D = specified starting diameter
ρo = liquid density
ρ = sample density
η = liquid viscosity
g = acceleration due to gravity
K = Stokes’ constant = 18

The Reynolds Number is displayed on the tabular report.
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C Data Reduction

LOG PROBABILITY

Log probability data are a transformation of cumulative mass finer data as a means of determining
how well cumulative and differential mass data represent statistical normal distributions. Since
cumulative mass finer data are essentially data indicating the probabilities of finding particles of
mass finer at given diameters, log normal probability data are a fit of the cumulative mass data to
the defined, symmetrical probabilities tabulated for a normal distribution.

The log probability table used is a subset of 99 points, ranging from (-2.88, 0.2%) to (0.0, 50.0%)
to (+2.88, 99.8%), from a standard normal distribution table (see log probability interpolation
table). The x-axis and y-axis data which are plotted on a log probability graph are calculated as
follows:

1. X-axis boundaries are determined by the spline interpolation at 0.2% and 99.8% from
cumulative mass finer vs. log diameter. This gives Xprob_beg and Xprob_end, respectively.

2. For each of the number of points collected,

If Diameter value is between Xprob_beg and Xprob_end and

if CumMassFiner value is between 0.2% and 99.8%, then

Xprob value = Diameter value

Yprob value = Spline interpolation at CumMassFiner values of the x vs. y log probability
table values

X(%) Y X(%) Y X(%) Y
0.20 -2.88 33.00 -0.44 68.08 0.47

0.99 -2.33 34.83 -0.39 69.15 0.50

2.02 -2.05 35.94 -0.36 69.85 0.52

3.01 -1.88 37.07 -0.33 70.88 0.55

4.01 -1.75 37.83 -0.31 71.90 0.58

4.95 -1.65 38.97 -0.28 72.91 0.61

5.94 -1.56 40.13 -0.25 73.89 0.64

6.94 -1.48 40.90 -0.23 74.86 0.67

7.93 -1.41 42.07 -0.20 76.11 0.71

9.01 -1.34 42.86 -0.18 77.04 0.74

10.03 -1.28 44.04 -0.15 77.94 0.77

Log Probability Interpolation Table
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X(%) Y X(%) Y X(%) Y
10.93 -1.23 44.83 -0.13 79.10 0.81

11.90 -1.18 46.02 -0.10 79.95 0.84

12.92 -1.13 46.81 -0.08 81.06 0.88

14.01 -1.08 48.01 -0.05 82.12 0.92

14.92 -1.04 48.80 -0.03 82.89 0.95

16.11 -.099 50.00 0.00 83.89 0.99

17.11 -0.95 51.20 0.03 85.08 1.04

17.88 -0.92 51.99 0.05 85.99 1.08

18.94 -0.88 53.19 0.08 87.08 1.13

20.05 -0.84 53.98 0.10 88.10 1.18

20.90 -0.81 55.17 0.13 89.07 1.23

22.06 -0.77 35.96 0.15 89.97 1.28

22.96 -0.74 57.14 0.18 90.99 1.34

23.89 -0.71 57.93 0.20 92.07 1.41

25.14 -0.67 59.10 0.23 93.06 1.48

26.11 -0.64 59.87 0.25 94.06 1.56

27.09 -0.61 61.03 0.28 95.05 1.65

28.10 -0.58 62.17 0.31 95.99 1.75

29.12 -0.55 62.93 0.33 96.99 1.88

30.15 -0.52 64.06 0.36 97.98 2.05

30.85 -0.50 65.17 0.39 99.01 2.33

31.92 -0.47 67.00 0.44 99.80 2.88

Log Probability Interpolation Table (continued)

C Data Reduction

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 C - 19



C Data Reduction

Standard Diameter Standard Mass %
300 95

250 90

200 85

150 80

100 75

80 70

60 65

50 60

40 55

30 50

25 45

20 40

15 35

10 30

8 25

6 20

5 15

4 10

3 5

1.5

1

0.8

0.6

0.5

0.4

0.3

0.2

0.1

Standard Report Tables
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D EXPORTED DATA EXAMPLE
This exported data has been truncated for this manual.

 Sample Information File

             Sample Information

        Sample:    MPSRM                    

      Operator:    AWT                      

     Submitter:    Micromeritics            

    Parameter 1    0.000                    

    Parameter 2    0.000                    

    Parameter 3    0.000                    

  Type of data:    Automatically collected  

                      Analysis Conditions

  Parameter set name:    Garnet Medium Particle Size Reference  

 Sample Properties

  Particle description:    Garnet       

               Density:    3.880 g/cm³  

           Liquid Properties

  Parameter set name:    Water         

      Classification:    Interpolated  

D Exported Data Example
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D Exported Data Example

 Table of User Entered Densities and Viscosities

  Temperature    Viscosity    Density  

(°C)         (mPa·s)     (g/cm³)  

---

  26.0           0.8737       0.9968   

  32.0           0.7679       0.9951   

  38.0           0.6814       0.9930   

    Analysis Control Parameters

  Starting diameter:    50.00 µm    

    Ending diameter:    0.18 µm     

      Analysis type:    High Speed  

                   Analysis Options

                MasterTech stir time:    30 s          

            MasterTech stirrer speed:    Low           

               MasterTech probe time:    15 s          

       Stop at selected mass percent:    No            

                Ending percent finer:    0.0           

                     Number of tests:    1             

       Leave pump on during analysis:    No            

  Wait for temperature stabilization:    Yes           

        Mixing chamber stirrer speed:    6             

               Full scale pump speed:    3             

             Bubble detection method:    Medium        

                Rinse after analysis:    Yes           

                        Rinse method:    Fixed Cycles  

                        Rinse cycles:    3             
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                    Rinse pump speed:    4             

                    Report Options

  Report ID:    Garnet Medium Particle Size Reference  

  Distribution Type:    Mass  

      Selected Test:    Last  

                                      Reference Sample:

  1)    C:\Users\Public\Documents\Micromeritics\SediGraph III
Plus\data\example\MPSRMCEN.SMP  

                                    Specification Samples:

  1)    C:\Users\Public\Documents\Micromeritics\SediGraph III
Plus\data\example\MPSRMCRS.SMP  

  2)    C:\Users\Public\Documents\Micromeritics\SediGraph III
Plus\data\example\MPSRMFIN.SMP  

                                       Overlay Samples:

  1)    C:\Users\Public\Documents\Micromeritics\SediGraph III
Plus\data\example\MPSRMCEN.SMP  

  2)    C:\Users\Public\Documents\Micromeritics\SediGraph III
Plus\data\example\MPSRMCRS.SMP  

  3)    C:\Users\Public\Documents\Micromeritics\SediGraph III
Plus\data\example\MPSRMFIN.SMP  
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D Exported Data Example

                     Peak selection type:    Automatic  

      Minimum percent of dist. to report:    5.0 %      

  Minimum valley depth to separate peaks:      0.00     

              Reports

            Combined Report    Yes  

  Standard Class Size Table    No   

       Standard Sieve Table    No   

        Particle Size Table    No   

  Cumulative Fraction Table    No   

           Cumulative Graph    Yes  

            Frequency Graph    Yes  

  Difference from Ref Graph    Yes  

          Out of Spec Graph    Yes  

              Rosin Rammler    No   

             Summary Report    No   

                   Baseline    Yes  

               Surface Area    No   

    Surface Area Population    No   

                     Number    No   

          Number Population    No   

            Log Probability    No   

           Advanced Reports    No   

                 Sample Log    No   

          Combined Report

  Standard Class Size Table    No   

       Standard Sieve Table    No   

        Particle Size Table    Yes  

  Cumulative Fraction Table    Yes  
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           Cumulative Graph    Yes  

            Frequency Graph    No   

  Difference from Ref Graph    No   

          Out of Spec Graph    No   

              Rosin Rammler    No   

             Summary Report    Yes  

                   Baseline    No   

               Surface Area    No   

    Surface Area Population    No   

                     Number    No   

          Number Population    No   

            Log Probability    No   

           Advanced Reports    No   

                 Sample Log    No   

    Cumulative Finer Mass Fraction vs. Diameter

         Plot Type:    Curve                        

           Overlay:    Samples                      

  Autoscale x-axis:    Yes                          

  Autoscale y-axis:    Yes                          

      X axis range:    0.0090  to  125,000.0000 µm  

      Y axis range:    -0.100  to  1.100            

            Mass Frequency vs. Diameter

         Plot Type:    Curve                        

           Overlay:    Tests                        

  Autoscale x-axis:    Yes                          

  Autoscale y-axis:    Yes                          

      X axis range:    0.0090  to  125,000.0000 µm  

      Y axis range:    -0.100  to  1.100            
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D Exported Data Example

 Cumulative Finer Mass Fraction Difference From Reference Graph

         Plot Type:    Curve                  

           Overlay:    Tests                  

  Autoscale x-axis:    No                     

  Autoscale y-axis:    Yes                    

      X axis range:    1.0000  to  7.0000 µm  

      Y axis range:    -1.0000  to  1.1000    

 Cumulative Finer Mass Fraction Out of Specification Graph

         Plot Type:    Curve                        

           Overlay:    Tests                        

  Autoscale x-axis:    Yes                          

  Autoscale y-axis:    Yes                          

      X axis range:    0.0090  to  125,000.0000 µm  

      Y axis range:    -1.0000  to  1.1000          

                   Collected Data

  Sample recorded at first analysis:    Garnet       

  Liquid recorded at first analysis:    Water        

             Use auxiliary baseline:    No           

                Mean baseline value:    135 kCnts/s  

                         Test Summary:

                                                    Mean    

               Cell        Liquid                   Full    

   Test     Temperature    Density    Viscosity     Scale   

  Number       (°C)        (g/cm³)     (mPa·s)     (kCnts)  

D - 6 SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022



-----

    1          35.0        0.9941      0.7226        84     

    2          35.0        0.9941      0.7227        84     

    3          35.0        0.9941      0.7227        84     

    4          35.0        0.9941      0.7227        84     

    5          35.0        0.9941      0.7227        84     

    6          35.0        0.9941      0.7227        84     

    7          35.0        0.9941      0.7227        84     

    8          35.0        0.9941      0.7227        84     

  Instrument name:    0003  

    Serial number:    0003  

                                        Test 1

                 Cumulative                   Cumulative                   Cumul-
ative  

   Particle         Mass        Particle         Mass        Particle         Ma-
ss     

   Diameter        Finer        Diameter        Finer        Diameter        Fin-
er     

(µm)        (Fraction)       (µm)        (Fraction)       (µm)        
(Fraction)  

------

      51.5822      0.997            7.7179      0.958            1.1548      0.0-
99     

      48.6968      0.997            7.2862      0.943            1.0902      0.0-
91     

      45.9727      0.997            6.8786      0.924            1.0292      0.0-
84     

      43.4010      0.996            6.4938      0.900            0.9716      0.0-
77     

      40.9732      0.996            6.1306      0.871            0.9173      0.0-
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70     

      38.6812      0.995            5.7876      0.837            0.8660      0.0-
64     

      36.5174      0.995            5.4639      0.799            0.8175      0.0-
58     

      34.4747      0.995            5.1582      0.756            0.7718      0.0-
52     

      32.5462      0.995            4.8697      0.711            0.7286      0.0-
46     

      30.7256      0.995            4.5973      0.663            0.6879      0.0-
41     

      29.0068      0.995            4.3401      0.615            0.6494      0.0-
37     

      27.3842      0.994            4.0973      0.568            0.6131      0.0-
33     

      25.8523      0.994            3.8681      0.522            0.5788      0.0-
30     

      24.4062      0.993            3.6517      0.478            0.5464      0.0-
27     

      23.0409      0.993            3.4475      0.437            0.5158      0.0-
24     

      21.7520      0.993            3.2546      0.400            0.4870      0.0-
22     

      20.5353      0.994            3.0726      0.366            0.4597      0.0-
20     

      19.3865      0.994            2.9007      0.335            0.4340      0.0-
18     

      18.3021      0.996            2.7384      0.307            0.4097      0.0-
15     

      17.2783      0.997            2.5852      0.283            0.3868      0.0-
13     

      16.3117      0.998            2.4406      0.261            0.3652      0.0-
11     

      15.3993      0.998            2.3041      0.242            0.3447      0.0-
08     

      14.5378      0.998            2.1752      0.224            0.3255      0.0-
06     

      13.7246      0.998            2.0535      0.209            0.3073      0.0-
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03     

      12.9569      0.997            1.9387      0.194            0.2901      0.0-
01     

      12.2321      0.996            1.8302      0.181            0.2738      -
0.002    

      11.5478      0.994            1.7278      0.168            0.2585      -
0.004    

      10.9018      0.992            1.6312      0.156            0.2441      -
0.005    

      10.2920      0.990            1.5399      0.145            0.2304      -
0.006    

       9.7163      0.987            1.4538      0.135            0.2175      -
0.006    

       9.1728      0.983            1.3725      0.125            0.2054      -
0.005    

       8.6596      0.977            1.2957      0.116            0.1939      -
0.003    

       8.1752      0.969            1.2232      0.107            0.1830      -
0.001    
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E SAMPLE DISPERSION
Use of the SediGraph requires that each powder be well dispersed in a liquid of known density
and viscosity and that the difference between the powder and liquid densities be accurately
known. Viscosity and density data for some common liquids are given in Sources of Dispersing
Aids on page I - 1. Handbook values for other liquids are usually sufficiently accurate, so the
latter requirement means that only the powder density must be determined if it is unknown and if
composition information does not permit calculation from handbook values. For this, one of
Micromeritics’ pycnometers is recommended. For materials likely to have dead-end pores into
which liquid may not completely penetrate, the effective density1 ) may need to be determined
using the sedimentation liquid to be employed and a gas pycnometer.

The liquid should be one in which the powder can be completely dispersed (separated into
unattached particles) for accurate size results to be obtained. Obviously, the liquid should be
nontoxic, readily available, and one in which the sample is insoluble. Complete insolubility may be
difficult to achieve in some instances. Solubility problems may be minimized by allowing the liquid
to stand in contact with the particle material prior to using the liquid for the test sample. This
cannot completely eliminate problems, however, because particle solubility is a function of particle
size. Small particles are more soluble than large ones. In a dispersion of different sizes, the
smallest particles tend to go into solution while precipitation occurs on the larger particles. In
making a particle size distribution analysis, particle solubility is indicated if the recorded
distribution consistently fails to attain zero percent even long after the analysis is complete.

There are no established rules or laws by which complete particle dispersion can be assured.
Only guidelines can be offered. Some powders disperse easily in any of several liquids and
remain so while others require careful attention to conditions in order to achieve dispersion and
are prone to reagglomerate if conditions shift a small amount. A few can be dispersed only after
extended treatments.

Agitation, resulting in the application of strong shear forces, aids dispersion. The more violent the
agitation— perhaps carried out in a high-speed blender, homogenizer, or an ultrasonic device—
the better generally is the dispersion. Stirring a suspension while subjecting it to ultrasonic
dispersion generally achieves the best dispersion because this ensures that all portions of the mix
are brought into the zones of greatest energy.

For a few friable materials such agitation can result in comminution of the particles for which
measurements are preferred. This is not likely to be the case with solid particles, particularly when
the particles are under 50 to 100 μm in diameter.

1 ) The procedure for determining the effective density is discussed in Application Note #94.
Contact your local sales representative or the Micromeritics sales office to request a copy.

E Sample Dispersion

SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022 E - 1



E Sample Dispersion

Air bubbles cause misleading results if trapped in the liquid during agitation. Care should be taken
to avoid bubble entrapment, especially when the liquid is highly viscous. The SediGraph performs
bubble elimination routines and checks to verify their effectiveness, but the best agitation
procedure is one that does not introduce them in the first place. The magnetic stirrer built into the
instrument is a convenient means for maintaining a homogeneous particle dispersion but will
cause flocculation in certain magnetically susceptible materials. With such particles, stirring can
be accomplished by using the ultrasonic dispersion accessory or the MasterTech.

Chemical wetting or dispersing agents also generally aid dispersion. A great variety of such
products are marketed. Chemical Aids for Particle Dispersion on page B - 1 and Sources of
Dispersing Aids on page I - 1 list some of the more useful dispersing aids, as well as sources for
some of these materials. These agents have been found useful for particle dispersion in
Micromeritics’ Materials Analysis Laboratory but are not the only agents available. It is to be noted
that liquid density and viscosity values may need slight adjustment if more than about 0.1% by
weight (based on the dry weight of the sample) of dispersing agent is added and precise
measurements are needed.

Some commercial surfactants are intended for use in specific pH ranges and in particular
nonaqueous solutions. Slight solution composition differences may alter the effectiveness of any
agent. The chemical supplier should be contacted about this type of problem. Sometimes merely
shifting the pH of an aqueous dispersion will yield great improvements in the degree of dispersion.
Metal oxides and metals that are likely to have oxide layers on their surface ordinarily are most
easily dispersed in mildly alkaline media. Metal powders with any likelihood of grease on them
should always be degreased prior to a dispersion attempt. Noble metal powders usually need a
wetting agent for good dispersion. Dispersions involving hydrocarbon liquids that are immiscible
with water are often difficult to make unless the powder is quite dry. Sometimes moisture picked
up from the air is more than enough to cause difficulties.

Micromeritics offers Sedisperse liquids in three series for dispersing particles at low solids
concentrations. A- and P-series are stable, balanced formulations containing highly purified,
saturated aliphatic hydrocarbons and added surfactants. A-series Sedisperse liquids are colorless
while the P-series are pale yellow. These liquids produce nearly universal dispersion of powder-
liquid systems with solids concentrations below three weight percent generally, and as much as
five weight percent in some cases. Sedisperse liquids solubilize adsorbed moisture.

W-series Sedisperse liquids are slightly anionic, non-foaming, aqueous formulations. They also
produce nearly universal dispersion of systems with concentrations generally below three weight
percent. Sedisperse liquids contain built-in surfactants and dispersants so that nothing else needs
to be added for the dispersion of particles except mechanical and / or ultrasonic energy. These
liquids are available over a range of densities and viscosities, thus making them applicable to
particles of widely varying properties. Sedisperse liquids are designed to be used without dilution
or the addition of surfactants, and exhibit good shelf life and stability. A data sheet is supplied with
each liquid giving handling details, density, and viscosity data over a temperature range of 24 to
45 °C.
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The A-series Sedisperse liquids are the most widely useful and will disperse most powders,
including metals, oxides, silicates, pigments, Portland cements, propellants, and many other
powders. Those few materials not dispersing well in the A-series liquids can usually be dispersed
in the P-series Sedisperse liquids. These are special formulations, slightly cationic, developed to
disperse difficult metal and pigmented resin powders. TheW-series Sedisperse liquids should be
used to disperse those materials which are soluble in the organic Sedisperse liquids. See
Sedisperse Particle Dispersion Liquids on page H - 1.

Some powders flocculate upon standing a few moments after having been dispersed. Such
flocculation is quite readily detected with the SediGraph. The indicated size distribution as plotted
by the instrument during a test will proceed normally until flocculation starts. The first evidence of
flocculation will likely be an increase in the indicated particle concentration and this will then be
followed by a precipitous drop in the plotted percentage. Flocculation, of course, prevents
accurate particle size analysis, and better dispersion and stabilization techniques must be sought.

As a general guide, the best dispersing technique (includes agent and procedure) is the one
producing consistently the finest distribution of sizes by SediGraph analysis. We make this
assertion because of the high reproducibility of the SediGraph when presented identical samples.
If the sample preparation technique is deficient in freeing particles one from another or if, though
unlikely, is producing particle fracture, this will be evidenced by an inconsistency of results.

The rheological behavior of high concentrations of fine powder in a liquid gives a good preliminary
indication of the suitability of both the liquid medium and the dispersing agent. Some powders
containing as much as 50 percent liquid act as if they were almost a solid mass, but a few tenths of
a percent of wetting agent can cause the mass to take on the consistency of soup. This reaction is
indicative of a very good agent. The effect will not often be so dramatic, but working the mass with
a spatula will give a good indication of the efficacy of an agent.

A test for the optimum quantity of a dispersing agent is conducted by measuring the sediment
volume from a slurry of about 5 weight percent concentration. The slurry and agent must be mixed
and allowed to stand in a sedimentation tube undisturbed by either mechanical vibrations or
thermal currents. The minimum sediment volume indicates the best agent concentration level. If
several dispersing agents are compared at the same time, the minimum sediment volume is also
a measure of the best dispersing agent.

No particular sample concentration is required in using the SediGraph as long as the dispersed
sample reduces the radiation beam intensity by 13 to 70 percent. The recommended procedure
for initial testing is to prepare a dispersion of approximately 5 volume percent concentration.
Portions of this preparation are added to pure suspending liquid until an adequate concentration
for analysis is achieved. The advantage of this procedure is that less concentrated dispersions
can generally be produced without fear of flocculation once the initial preparation is made.
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F SEDIGRAPH RESULTS RELATIVE TO OTHER METHODS

The SediGraph 5100 Analyzer, sieve analysis, and hydrometer measurements yield particle size
distributions on a mass (weight) basis. Microscopic measurements result in size data as a function
of the number of particles. Measurements that involve light scattering, transmission, or diffraction
relate size most appropriately to particle cross sectional area. Particle counting systems, electric
zone sensing, gives size in terms of particle volume.

Mass-based measurements can be expected to be in agreement with respect to their reliability
and the applicability to the size range involved, provided the particles are spherical and solid.
When the particles are irregular, close agreement should not necessarily be anticipated. Sieve
analysis, for example, must be very carefully performed with fine particles to ensure complete
separation according to size without damaging the sieves. Even so, the size determined is not
necessarily the same as that measured by the SediGraph. The SediGraph determines the size of
all particles in terms of the E.S.D. (equivalent spherical diameter). Since sieve openings are
usually square, elongated particles sometimes pass a given sieve in one orientation and at other
times are retained. These differences obviously lead to differences in results.

Light-based instruments incorporate various means for tuning, calibrating, and data reduction,
which can make them agree satisfactorily for some materials with most any one of the other
techniques. Any setting is dependent to a degree on the refractive index of the measured
particles; however, so agreement cannot be general or over all particle size ranges. The shape of
the particles also influences all results.

Mass and volume measurements are equivalent numerically. Therefore, analyses with the
SediGraph and the electric sensing zone can be expected to agree if the particles are spherical,
solid, and if their size range is sufficiently narrow for all of them to be accurately detected by the
electric sensing zone.

Again, precise agreement is not to be expected with irregular particles, for the electric sensing
zone measures something closely akin to the diameter an irregular particle would assume were it
melted into a sphere. This is not necessarily the equivalent spherical diameter.

Microscopic measurements yield particle diameters that, for spheres, are essentially E.S.D. As
before, measured sizes will deviate from E.S.D. when the particles are irregular— the greater the
irregularity, the greater the deviation. The numbers will not correspond even approximately
because, as noted above, the measurements are on a different basis. However, number-based
measurements are readily converted into mass-based (or volume-based) results by applying the
relationship to incremental sizes.
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F SediGraph Results Relative to Other Methods

where Y is the mass percent of particles having the diameter D and n the number of particles of
that diameter. The denominator, therefore, represents the entire spectrum of sizes. The following
tabulation presents number-based data and calculations leading to the number-based and mass-
based diameter distributions.

Particle
Diameter
Range
(μm)

D
Largest
Diameter
Within
Range
(μm)

n
Number of
Particles
Within
Range

Percent
by

Number
Less than
Diameter

nD3
Percent by

Mass
Less
Than

Diameter

5.4 - 5.0 5.4 10 100.0 1575 0.0481 0.0481
100.0

4.9 - 4.5 4.9 51 99.2 6000 0.1833 95.2

4.4 - 4.0 4.4 65 95.3 5537 0.1692 76.9

3.9 - 3.5 3.9 70 90.3 4152 0.1269 59.9

3.4 - 3.0 3.4 133 84.9 5227 0.1597 47.3

2.9 - 2.5 2.9 160 74.6 3902 0.1192 31.3

2.4 - 2.0 2.4 288 62.3 3981 0.1216 19.4

1.9 - 1.5 1.0 271 40.1 1859 0.0568 7.2

1.4 - 1.0 1.4 162 19.2 445 0.0136 1.5

0.9 - 0.5 0.9 72 6.7 52 0.0016 0.2

0.4 - 0 0.4 14 1.1 1 0.0000 0.0

1296 = ∑n 32731 = ∑nD3
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G SEDIMENTATION THEORY

CALCULATIONS
Sedimentation size analysis is based upon the fact that the measured equilibrium velocity of a
particle through a viscous medium, resulting from the action of the gravitational force, can be
related to the size of the particle by Stokes’ law. For spherical particles, Stokes’ law is expressed
by:

(1)

where

(2)

and D is the diameter of the spherical particle, v its equilibrium sedimentation velocity, and ρ its
density. The fluid medium is characterized by viscosity η and density ρo ; g is the acceleration of
gravity. These equations apply rigorously as long as the particle Reynolds number, Dvρo/η, is less
than 0.3 and they apply up to a Reynolds number of 0.5, with about 3% error.1 )

In practice, truly spherical particles are seldom encountered, and Stokes’ law is not exact for any
other shape. Since irregular shapes cannot in any case be described by a single linear dimension,
it is accepted practice to specify the size of non-spherical particles in terms of the diameter of a
sphere of the same material that would have the same sedimentation velocity. Thus, for non-
spherical particles, the terms “Stokes’ diameter” or “equivalent spherical diameter” are universally
understood. The term “equivalent spherical diameter” (E.S.D.) is sometimes used in a different
context to mean the diameter of a sphere of the same material that would have the same mass as
the particle in question; that is, the results of measurements of particle dimensions from electron
micrographs are frequently reduced to size distribution curves in terms of mass E.S.D. In general,
the relationship between these two measures of size is given by the inequality.

(3)

The ratio expressed in equation (3) is usually close to unity.

Data on the sedimentation velocity of suspended particles may be obtained in two ways: (a) by
measuring the concentration of particles remaining in suspension as a function of time, or (b) by
measuring the quantity of sediment produced as a function of time. The latter approach is less
desirable mathematically because of the graphical differentiation required to reduce the data to a
size distribution curve.

1 ) Lapple, C.E., et al, Fluid and Particle Mechanics, University of Delaware, Newark, 1956.
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G Sedimentation Theory

Tests based on the first approach are traditionally performed in the following way. A dilute,
dispersion of the fine particle material is stirred to render it homogeneous and then allowed to
stand undisturbed while undergoing sedimentation. Time is measured from the beginning of the
settling period. By Stokes’ law, a particle of diameter D will settle a distance h in time t according to
the expression:

(4)

where K is given by equation (2). Consequently, after a given time ti all particles larger than the
corresponding diameter Di will have fallen below a given distance h from the surface of the
suspension. If the initial (uniform) concentration of material is Co g/cm3 and the concentration
after time ti at distance h is Ci g/cm3, then Pi, the weight percent of material finer than Di, is given
by:

(5)

By obtaining values of Ci after various times, the corresponding values of Pi and Dimay be
calculated, which when plotted yield an integral, or cumulative distribution of particle size in terms
of Stokes’ E.S.D.

The SediGraph uses a finely collimated X-ray beam to measure particle concentration in terms of
the transmitted intensity of the X-ray beam through the suspension relative to the clear or particle-
free suspending fluid. This transmittance is a function of the weight concentration of the
suspended solid at the depth of measurement. Since the X-ray beam can be made extremely
small and because it does not disturb the suspension, it constitutes an ideal measuring technique.

If a sample container or cell of rectangular cross section is irradiated from a direction
perpendicular to one of its sides by a collimated X-ray beam, the fraction of the incident radiation
transmitted by the cell when filled with the suspension under study is given by:

(6)

where I and Io are the transmitted and incident intensities; a1, as, and ac the X-ray absorption
coefficients of the liquid, the particulate solids, and the cell walls, respectively; ɸ1 and ɸs the
weight fractions of liquid and solid present in the suspension; L1 the internal cell thickness in the
direction of irradiation; L2 the total thickness of the cell walls. By using the relation ɸ1=1-ɸs and by
defining a transmittance T as the ratio of the transmission of the cell when filled with a sample
dispersion to its transmission when filled with pure suspending liquid, there is obtained:

(7)

or
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(8)

where A is a constant for the particular apparatus and suspension components.

By collimating the X-ray beam through horizontal slits with a vertical dimension small compared to
the sedimentation depth, h, the measured values of T can be used in calculating the particle size
distribution; that is:

(9)

where To refers to the transmittance of the initial suspension.

METHOD OF ANALYSIS
Generally, the sedimentation method derives its results from the rates that different size particles
fall in a liquid due to the force of gravity. Rate, as used here, is the distance that a particle falls in a
certain period of time. The scientific law which describes the rate that particles fall in a liquid is
called Stokes’ Law. Large particles fall at a faster rate than smaller particles, as shown in the
following illustration.

A. Lowest Falling Rate
B. Highest Falling Rate

In order to determine particle diameters accurately using the falling rates of particles, the density
and viscosity of the liquid used must be known as well as the density of the particles. Density is the
mass of a material that it takes to fill a unit of space. Viscosity may be thought of as the resistance
of the liquid applied to falling particles. For example, a particle falls much slower in syrup than in
water because syrup has a higher viscosity. It should also be noted that temperature affects both
the density and viscosity of liquids; therefore, the temperature of the liquid must be known for
particle size determinations to be accurate.

G Sedimentation Theory
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G Sedimentation Theory

The falling rates for various particle sizes are computed before analysis using Stokes’ Law. A
vertical distance and an elapsed time are selected for each falling rate such that a particle falling
at a certain rate will fall a certain distance in a selected time. Relative particle concentration is then
measured at the selected distance and time.

Initially, a completely mixed (homogeneous) suspension of particles is established in a container
by rapidly circulating the mixture. The circulation is stopped, and the relative concentrations of
particles are measured at the selected vertical distances from the top of the container and at the
selected elapsed times after circulation is stopped.

The particle size associated with each concentration measurement is the size of the largest
particle present at the height and time of the measurement. All particles larger than that size have
higher falling rates, and have fallen to a lower point in the container. Smaller particles are still
present at equal concentrations just above and below the specified point. Thus, the concentration
measured at the specified point is the concentration of particles smaller than or equal to that size.

This series of relative concentrations of particles smaller than various sizes is the particle size
distribution.

% Maximum Concentration at Typical Specified Points

Since different particles usually have different shapes, the standard measure used to report
particle size is Equivalent Spherical Diameter. This is the diameter of a sphere (or perfectly
rounded mass) of the same material with the same falling rate.

SYSTEM OPERATION

The sedimentation method is used for particle size analysis in the SediGraph. The rates of particle
fall due to gravity are calculated and X-ray absorption (concentration) of particles at different
heights and points in time are determined, and the results of those determinations are provided as
graphs and tabular reports. Sedimentation analysis takes place in the analyzer. Data are sent to
the computer which provides the graphs and tabular reports.
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The material to be analyzed is dispersed in a liquid, according to the type of analysis to be
performed. (For more information concerning the relationship of dispersion to the type of analysis,
see appendices B and C.) At the appropriate time, the dispersed mixture is poured into the mixing
chamber on the front of the analyzer.

A magnetic stirrer located under the mixing chamber keeps the particles suspended (that is,
keeps the particles from sedimenting) until it is time for the analysis. The stirring speed can be
adjusted as required to properly suspend the particles. If the particles to be analyzed are attracted
to the magnetic stirrer, the magnetic stirrer can be replaced with a mechanical stirrer. If the
dispersion energy required to keep the particles in a dispersed state in the mixing chamber is
more than can be provided by the stirrer used, an ultrasonic probe can be inserted into the mixing
chamber.

Sedimentation takes place inside an analysis cell as shown in the following illustration. At the
appropriate time, the particle mixture is transferred by the analyzer from the mixing chamber to the
analysis cell. Particle circulation is stopped, and the particles are allowed to sediment (or fall)
inside the analysis cell under the influence of gravity. The SediGraph then determines the particle
size distribution.

A. Lowest Falling Rate
B. Highest Falling Rate

An X-ray beam (made up of a number of fine parallel rays) is provided from a source inside the
analyzer. A unit which detects X-rays is placed directly across from the X-ray source. The analysis
cell is placed in the path of the X-ray beam, between the X-ray source and the detector. The cell
contains a window on each side so that the X-rays can pass through the cell to the detector.
Sedimenting particles (particles falling under the influence of gravity) inside the cell cross the path
of the X-ray beam. The particles in the path of the beam absorb X-rays (that is, the particles keep
some X-rays from reaching the detector). The amount of X-ray absorption at the point in the cell
where the beam is located is determined as a percentage of the X-ray absorption with the highest
particle concentration for that sample. Based upon particle falling rates, this percentage is related
to the maximum particle size above that point in the cell.
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A. X-Rays
B. X-Ray Source
C. Sample Cell
D. Particle
E. X-Ray Detector

The SediGraph system uses both particle falling rates and the amount of X-ray absorption for
particle size analysis. Particle falling rates (according to Stokes’ Law) are used to determine the
points in the cell beyond which certain size particles have fallen. X-ray absorption is used to
determine the percentage of total particle mass at different points in the cell. The resulting particle
size distribution data are processed by the system computer and used to provide graphs and
tabular reports which provide details of the analysis.

PARTICLE FALLING RATES

Particle falling rates are very significant in the determination of particle size distribution. However,
there are several important considerations in the accurate determination of particle falling rates.
There must be a reference point for measuring particle falling distances. The SediGraph uses an
automatic beam-split feature for establishing a reference point. Small particles have a low falling
rate, which could require considerable amounts of time for analysis. The SediGraph uses cell
movement during analysis to shorten analysis times by measuring small particle concentration at
very short sedimentation distances. Cell movement does not affect particle falling rates within the
cell. Particle dispersion also affects falling rates; therefore, proper particle dispersion is required
when using the SediGraph.

Beam-Split

A. X-Ray Source
B. 100% Beam
C. 50% Beam
D. Detector
E. Inside Top of Cell
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Since the top of the cell is used as the reference point for measuring particle falling rates, the
exact position of the cell (relative to the X-ray beam) must be known in order for particle falling
rates to be correct. The SediGraph determines the position of the cell by moving the cell to the
point where the top edge of the cell splits the X-ray beam (exactly in half), and by storing this
beam-split data in the system computer so that this position can be located for the next analysis.
Beam-split is done automatically by the system at the start of any automatic scanning operation;
no message is displayed on the monitor unless beam-split cannot be performed for some reason.

Cell Movement

A. Cell is Moved Down

The cell is attached to an elevator assembly which moves the cell down during analysis to speed
the data collection process. The system computer performs the calculations associated with
particle falling rates as the distances and times are changed according to the movement of the
cell. For example, as shown in the cell movement illustration, it might take 30 minutes for the
particle shown to fall the distance from the top of the cell to the X-ray beam; however, by moving
the cell down, the particle reaches the beam in, perhaps, three minutes. The system computer
uses this time and distance in determining the particle falling rate.

Particle Dispersion

The particle falling rates also depend upon how well the particles in the cell are dispersed (or
separated). Joined particles behave as a single particle with a greater falling rate than if the joined
particles were separate (as shown in the following illustration).

A. Joined Particles Have Higher Falling Rate
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X-RAY ABSORPTION

In addition to particle falling rates, the SediGraph uses the relative amount of X-ray absorption as
part of the analysis process. As falling particles in the cell cross the path of the X-ray beam, they
absorb X-rays. In order for X-ray absorption to be used for measuring the distribution of particle
masses in the cell: (1) the minimum and maximum X-ray absorption must be determined for each
X-ray absorption measurement point in the cell; (2) any bubbles in the cell must be detected and
eliminated; and (3) the particles must be properly dispersed, as explained in Appendices B and C.

Baseline (Minimum) Absorption

In order for the X-Ray absorption values to be accurate, a reference (or baseline) must be used
with each value. This baseline is the amount of X-ray absorption with no particle mass present.
However, since the sedimentation liquid also absorbs X-rays, the amount of X-ray absorption for
the liquid must be included in the baseline. The shape of the cell, or cell profile, affects the
accuracy of baseline X-ray absorption values. The SediGraph automatically determines the
baseline and makes baseline corrections for any changes in the shape of the cell. This feature is
called baseline correction. Let’s look at how it works.

When instructed, the SediGraph performs an X-ray scan of the cell filled only with the selected
sedimentation liquid. The reason for this scan is to determine the amount of X-ray absorption of
the cell and liquid alone before any particles are introduced. The scan progresses from the bottom
of the cell toward the top in exactly the same manner as will be done when sample particles are
present.

As the cell is scanned, X-ray absorption reference values (referred to as baseline values) are
determined at many points along the cell. The baseline value is the amount of X-ray absorption at
that point in the cell. The baseline value is for 0% concentration since the cell contains only the
sedimentation liquid and no particles.

A. X-Rays
B. X-Ray Source
C. Sample Cell
D. X-Ray Detector
E. Clear Liquid in Cell

Slight differences in the cell thickness at the measurement points (up to 250) along the cell
change the amount of X-ray absorption for those points. The amount of X-ray absorption at each
point is stored in the system computer and recalled during the analysis to adjust the baseline at
those same points in the cell.
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The baseline values do not change unless the sedimentation liquid changes, the shape of the cell
changes, or the X-ray intensity changes. It is, however, recommended that you obtain a baseline
measurement at the beginning of each shift or whenever a different dispersant (or a new batch) is
to be used. This assures accurate analysis results. The baseline operation is selected from the
Unit [n] menu.

Full-Scale (Maximum) Absorption

Before each analysis, the SediGraph examines the cell filled with particles suspended in liquid
(particles not allowed to sediment). As the cell is being examined, a full-scale X-ray absorption
value (or maximum absorption) is determined for each point along the cell as shown in the
following illustration. This full-scale absorption value is for 100% concentration, since the cell
contains suspended particles, which represents the highest particle concentration for that
analysis. The full-scale absorption values change with each analysis since a different number and
composition of particles is used.

A. X-Rays
B. X-Ray Source
C. Sample Cell
D. Particle
E. X-Ray Detector

The X-ray absorption is measured at up to 250 positions in the cell. This may be reported on the
Baseline / Full scale report. The full scale scan used in the analysis is computed as the average of
10 readings measured at a fixed position.

The full-scale absorption profile operation is performed automatically by the system. Since
baseline absorption and full-scale absorption are known for each analysis point in the cell before
the analysis, the absorption during the analysis is a percentage somewhere between baseline and
full-scale. Using particle falling rate determinations, the system determines the size of the
particles which have fallen beyond the specific analysis point in the cell. Therefore, the absorption
percentage at each specific analysis point in the cell indicates the percentage of particles that are
below a certain particle size. When this is done for a number of points in the cell, the particle size
distribution can be determined.

G Sedimentation Theory
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G Sedimentation Theory

Bubble Detection / Elimination

If air bubbles are formed in the cell during analysis, the amount of X-ray absorption at those points
will be detected as a sharp, discrete change. This would make the analysis results invalid. In order
to prevent this, the SediGraph has a built-in bubble detection and elimination feature. This feature
automatically detects and removes bubbles from the cell. A message is displayed on the screen
indicating this operation is in process.

A. Bubbles
B. Cell Tilted for Bubble Discharge

G - 10 SediGraph III Plus Operator Manual
512-42835-01 (Rev B) — Sep 2022



H SEDISPERSE PARTICLE DISPERSION LIQUIDS
Sedisperse A-series and P-series liquids are stable, balanced formulations for dispersing
insoluble particles. These liquids are primarily saturated aliphatic hydrocarbons. Sedisperse A-
series liquids are colorless while P-series liquids are pale yellow. These liquids produce nearly
universal dispersions of powder-liquid systems with solids concentrations below three weight
percent and to as much as five weight percent in some cases. Sedisperse liquids solubilize
adsorbed moisture.

Sedisperse W-series liquids are slightly anionic, non-foaming, aqueous formulations for
dispersing insoluble particles. They also produce nearly universal dispersions of systems with
solids concentrations generally below three weight percent.

Sedisperse liquids are non-irritating, non-toxic, non-carcinogenic, and non-explosive. The organic
Sedisperse liquids will burn, but will not support combustion at room temperature.

STORAGE REQUIREMENTS
Keep containers closed. Keep containers from freezing. If a container develops a leak during
storage, transfer it to another clean container. Spillage may be cleaned using detergent and
water. Sometimes particles may crystallize and settle out of Sedisperse liquids during storage.
This is usually a result of exposure to cold temperatures. It is corrected by warming the
Sedisperse to 40-50 °C and then vigorously shaking the liquid in a closed container to re-dissolve
the particulates. Micro-organisms may also begin to grow in Sedisperse W-series liquids. These
can usually be removed by filtering and the liquid is again usable for particle dispersion.

TECHNICAL DATA
Recommended techniques for using these liquids:

1. Disperse particles using energy from an ultrasonic bath or probe accompanied by
continuous, moderate mechanical agitation to force particles through the nodes of the
standing ultrasound waves.

2. For sedimentation particle size analysis, first disperse the powder in Sedisperse and
estimate the size of the largest particles using a microscope. Next, calculate the liquid
viscosity needed by using the relationship.

H Sedisperse Particle Dispersion Liquids
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H Sedisperse Particle Dispersion Liquids

where

η = minimum viscosity permitted in mPa•s (or cp)
Dmax = equivalent spherical diameter of the largest particles in μm
ρ = density of the particles in g/cm3

MATERIAL PROPERTIES
AMaterial Safety Data Sheet (MSDS) is supplied with each purchase. It should be consulted for
the following information:

n Oral toxicity
n Local effect on eyes
n Local effect on skin
n Shock sensitivity
n Decomposition characteristics
n Heat generation characteristics
n Recommended extinguishing agents
n Hazard by inhalation
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FIRST AID TREATMENT
The Material Safety Data Sheet (MSDS) supplied with each liquid should be consulted for the
following first aid information:

n Skin contact
n Eye contact
n Inhalation
n Antidote in case of swallowing

H Sedisperse Particle Dispersion Liquids
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I SOURCES OF DISPERSING AIDS
Dispersant Source
Aerosol OT
Aerosol 22

American Cyanamid Company, Process Chemicals Department,
One-T Cyanamid Plaza, Wayne, NJ 07470

Calcium Chloride Can be purchased at most laboratory supply houses.

Calgon
Calgon T

Calgon Corporation, Water Management Division, Calgon Center, P.
O. Box 1346, Pittsburgh, PA 15230

Cobalt Citrate Shepherd Chemical Company, Cincinnati, OH 45212

Cobaltous Chloride Can be purchased at most laboratory supply houses.

Daxad 23, 30 Hampshire Chemical Corporation, 55 Hayden Avenue, Lexington,
MA 02173

Dispex 40 Allied Colloids, 2301Wilroy Road, Suffolk, VA 23434

FC-134, -161 and -170 3M Company, Chemical Division, St. Paul, MN 55141

Igepal CO-530 GAF Corporation, 1361-T Alps Road, Wayne, NJ 07470

Lomar D Henkel, 300 Brookside Avenue, Ambler, PA 19002

Oleic Acid Can be purchased at most laboratory supply houses.

Renex 648
Tween 20
Atlas G-3300

ICI Americas, Inc., Chemical Division, New Concordville Pike, Wilm-
ington, DE 19897

Triton X-100
Tamol SN

Rohm and Haas Company, Independence Mall West, Philadelphia,
PA 19105

Sodium Silicate N Brand Philadelphia Quartz Company, 1301-T E. Fort Avenue, Baltimore,
MD 21230

Pyrophosphate (TSPP) Can be purchased at most laboratory supply houses.

Zonyl A, S-13 E. I. DuPont de Nemours and Company, Dyes and Chemical Divi-
sion, 1000-T Market Street, Wilmington, DE 19898

I Sources of Dispersing Aids
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J STOKES' LAW
A particle falling due to gravity in a viscous liquid is acted upon by three forces: a gravitational
force acting downward, a buoyant force acting upward, and a drag force acting upward. The
descriptive equation of this motion is

(1)

where m is the mass of the particle, mo the mass of a volume of liquid equal to the volume of the
particle, g the acceleration of gravity, FD the drag force, v the particle velocity, and t the time.

Small particles reach a stable, or terminal, velocity very rapidly; hence, dv/dt quickly becomes
zero. The equation of motion for a sphere of diameter D and density ρ falling in a liquid of density
ρo then becomes

(2)

Dimensional analysis reveals that stable particle motion through a liquid is governed by two
dimensionless groups: the particle Reynolds number Re

(3)

where η is the liquid viscosity, and a drag coefficient CD expressed by

*

(4)

The relationship between Re and CD for laminar (not turbulent) flow conditions is well established
experimentally for low values of the Reynolds number to be

(5)

Combining equations (2) through (5) yields

↕

which has come to be identified as the Stokes law equation1 ) .

1 ) Stokes, G.G., Mathematical and Physical Paper III, Cambridge University Press, 1891.

J Stokes' Law
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